0  Content
0.1  Document History ................................................................. 0-7
0.2  Trademarks ........................................................................ 0-7

1  About this Manual
1.1  Conventions Used in this Manual ........................................ 1-3

2  About Saia PCD® Supervisor
2.1  Saia PCD® Supervisor Architecture .................................... 2-2
2.1.1  Platform ........................................................................... 2-2
2.1.2  Station .............................................................................. 2-2
2.1.3  Platform Daemon ............................................................ 2-3
2.1.4  SBCIpNetwork driver ..................................................... 2-3
2.1.5  Other Drivers (open points) ............................................. 2-3
2.2  User Interface Application (Host PC) ................................. 2-4
2.2.1  Nav Tree (navigation panel) .............................................. 2-4
2.2.2  Palettes .......................................................................... 2-4
2.2.3  Locator Bar ..................................................................... 2-5
2.2.4  View Pane & View Changer ............................................ 2-5
2.2.5  Client Devices ................................................................. 2-6

3  Securing Saia PCD® Supervisor
3.1  Introduction ........................................................................ 3-1
3.2  Disaster Recovery Planning ............................................... 3-1
3.3  Physical and Environmental Considerations ..................... 3-1
3.4  Security Updates and Service Packs .................................. 3-1
3.5  Virus Protection ................................................................. 3-2
3.6  Network Planning and Security ......................................... 3-2
3.7  Virtual Environments .......................................................... 3-2
3.8  Securing Wireless Devices .................................................. 3-2
3.9  System Monitoring ............................................................. 3-3
3.10  Securing Access to the Operating System ......................... 3-3
3.11  Access Control ................................................................. 3-3
3.12  Securing Saia PCD® Supervisor ....................................... 3-3
3.12.1  Default Admin User of a Station .................................... 3-3
3.12.2  Passphrase .................................................................... 3-4
3.12.3  Set up Other Users for the Station ............................... 3-4
3.13  Saia PCD® Supervisor Security Check List ...................... 3-4

4  Installing Saia PCD® Supervisor
4.1  Installation Requirements .................................................... 4-2
4.2  Obtaining the Saia PCD® Supervisor Software ................... 4-2
4.3  Installing the Saia PCD® Supervisor Software ................. 4-3
4.4  Installing the Platform Daemon ........................................ 4-6
4.5  Configuring the Windows Firewall .................................... 4-6
5 Licensing Saia PCD® Supervisor
5.1 Obtain a Saia PCD® Supervisor License and Certificate ........................................ 5-1
5.2 Install the Saia PCD® Supervisor License .............................................................. 5-1
5.2.1 Automatic Licensing ......................................................................................... 5-2
5.2.2 Manual Licensing ............................................................................................. 5-2
5.3 Updating a License ............................................................................................... 5-2

6 Creating/Engineering a project (application, site, ..)

6.1 Initial Setup ........................................................................................................ 6-2
6.1.1 Launch the Saia PCD® Supervisor Application .............................................. 6-2
6.1.2 Open the Platform ......................................................................................... 6-2
6.1.3 Create a New Station ....................................................................................... 6-5
6.1.4 Open the Station .............................................................................................. 6-9
6.2 Manual creation of data points .............................................................................. 6-11
6.2.1 Add a Saia Burgess Controls driver (SBCIpNetwork) ..................................... 6-11
6.2.1.2 Create a folder for Saia Burgess Controls Driver ....................................... 6-12
6.2.1.3 Add the Saia Burgess Controls Driver ....................................................... 6-13
6.2.2 Configure the Saia Burgess Controls Driver(s) ............................................... 6-16
6.2.3 Adding Device to the Saia Burgess Controls Driver(s) ..................................... 6-17
6.2.4 Add Points to the Device to get the data from the PCD .................................. 6-21
6.2.5 Add Alarming to a data point in the Saia PCD® Supervisor ............................. 6-25
6.2.5.1 Steps to set alarming to a datapoint .......................................................... 6-26
6.2.6 Add History to a data point in the Saia PCD® Supervisor ............................... 6-35
6.2.6.1 Steps to setup History for a datapoint in the Saia PCD® Supervisor .......... 6-35
6.3 Using the “Saia PG5 Data Import Wizard” ......................................................... 6-40
6.3.1 Preparation ...................................................................................................... 6-41
6.3.2 Importing symbols from PG5 projects ............................................................. 6-43
6.3.2.1 Properties of an imported datapoint ......................................................... 6-52
6.3.3 Alarming ......................................................................................................... 6-56
6.3.4 Importing Historically logged data so called HD Logs ................................. 6-59
6.3.5 Starting the communication after the import .................................................... 6-61
6.3.5.1 Enabling the Saia S-Bus IP-Driver ............................................................... 6-62
6.3.5.2 Checking different settings to get the communication working ............... 6-63
6.3.5.3 Tuning the Saia S-Bus IP-Driver ................................................................. 6-66
6.4 General functions .............................................................................................. 6-68
6.4.1 Configure Scheduled tasks .............................................................................. 6-68
6.4.2 Creating folder for the scheduling components .............................................. 6-72
6.4.3 Add Weekly Scheduler component from Palette ............................................ 6-73
6.4.4 Configuring normal events weekly schedules ............................................... 6-74
6.4.5 Configuring special events weekly schedules ................................................. 6-75
6.4.6 Add Calendar Scheduler component from the Palette .................................. 6-78
6.4.7 Configuring Calendar Schedule ...................................................................... 6-79
6.4.8 Make the logic to control the physical point in the PCD device ..................... 6-81
6.4.9 Make the logic to control the physical point in the PCD device using reference between the schedulers. .................................................. 6-86

6.5 Connect to 3rd Party Systems ........................................................................... 6-89
6.5.1 Add the Required 3rd Party Drivers ............................................................... 6-89
6.5.2 Configure 3rd Party Drivers .......................................................................... 6-90
6.5.3 Add 3rd Party Points to the Database ............................................................. 6-90
6.5.4 Using the BACnet Driver .............................................................................. 6-90
6.5.4.1 Configure the BACnet Driver ................................................................. 6-90
6.5.4.2 Discover and add BACnet Devices .................................................. 6-92
6.5.4.3 Add the required BACnet Points to the Database ......................... 6-94
6.6 Creating Schematics (Operator Views) ................................................... 6-97
  6.6.1 Prepare the folder structures ............................................................... 6-97
  6.6.1.1 Create a Folder for the Operator Views ......................................... 6-97
  6.6.1.2 Create a Folder for the Images .................................................... 6-98
  6.6.1.3 Prepare Images ........................................................................... 6-98
  6.6.1.4 Add Images to Saia PCD® Supervisor ........................................ 6-98
  6.6.1.5 Customize the basic PX Template Page ....................................... 6-99
  6.6.2 Create a PX Page ............................................................................ 6-100
  6.6.3 Edit a PX Page ................................................................................ 6-101
    6.6.3.1 Create or Change PX Page Elements ......................................... 6-101
    6.6.3.2 Setting the Page Size and Background ...................................... 6-101
    6.6.3.3 Add Text .................................................................................. 6-102
    6.6.3.4 Add an Image ........................................................................... 6-102
    6.6.3.5 Add a Dynamic Object (Value) .................................................. 6-103
    6.6.3.6 Add an Animated Image .............................................................. 6-104
    6.6.3.7 Add a Setpoint Slider ................................................................. 6-105
    6.6.3.8 Add a Button to Adjust a Value ................................................ 6-106
    6.6.3.9 Add a Link to Another Page ....................................................... 6-107
    6.6.3.10 Add a Graph ........................................................................... 6-108
  6.6.4 Reuse Operator Views ........................................................................ 6-109
  6.6.5 Reuse a Generic PX Page .................................................................. 6-112
  6.6.6 Dashboards ..................................................................................... 6-115
    6.6.6.1 Add the Dashboard Service ....................................................... 6-116
    6.6.6.2 Add a Dashboard to a PX Page ................................................ 6-117
  6.7 Set Up Saia PCD® Supervisor Users ..................................................... 6-119
    6.7.1 Configure Categories ..................................................................... 6-120
    6.7.1.1 Add a Category ......................................................................... 6-120
    6.7.1.2 Set up the Categories ................................................................. 6-121
    6.7.2 Configure Roles ............................................................................ 6-123
    6.7.3 Configure Users ............................................................................ 6-125
    6.7.3.1 Configure NAV Files ................................................................. 6-125
    6.7.3.2 Create a Folder for the NAV Files ............................................. 6-125
    6.7.3.3 Create NAV Files ...................................................................... 6-126
    6.7.4 Add Users .................................................................................... 6-128
  6.8 Backup & Restore ................................................................................ 6-131
    6.8.1 Backup the Configuration .............................................................. 6-132
    6.8.2 Using the Backup Service .............................................................. 6-135
    6.8.3 Restore the Configuration .............................................................. 6-137
    6.8.3.1 Restore Using the Station Copier .............................................. 6-137
    6.8.3.2 Restore the Station Using the dist file ...................................... 6-137

7 Using Saia PCD® Supervisor
  7.1 Access Saia PCD® Supervisor .............................................................. 7-2
    7.1.1 Launch the Saia PCD® Supervisor Application ................................ 7-2
    7.1.1.1 Log on ..................................................................................... 7-4
    7.1.1.2 Log off .................................................................................... 7-4
    7.1.2 Access Saia PCD® Supervisor from a Web Browser ...................... 7-5
0

7.1.2.1 Log off ........................................................................................................ 7-7
7.2 Use Saia PCD® Supervisor ........................................................................ 7-8
  7.2.1 Using Saia PCD® Supervisor via Operator Views ............................... 7-8
    7.2.1.1 Access the Operator Views .............................................................. 7-8
    7.2.1.2 Use the Operator Views ................................................................. 7-8
    7.2.1.3 Use Dashboards ........................................................................... 7-9
    7.2.1.4 Configuring a Dashboard ............................................................... 7-10
  7.2.2 Using Saia PCD® Supervisor via the Nav Tree .................................... 7-11
    7.2.2.1 Basic Controls and Navigation ...................................................... 7-11
    7.2.2.2 Nav Tree ..................................................................................... 7-11
    7.2.2.3 Palettes ...................................................................................... 7-11
    7.2.2.4 Locator Bar .................................................................................. 7-11
    7.2.2.5 View Pane & View Changer ............................................................ 7-12
    7.2.2.6 Viewing and Changing values of a Point .................................... 7-12
    7.2.2.7 Viewing Alarms .......................................................................... 7-13
    7.2.2.8 Using the Alarm Console .............................................................. 7-14
    7.2.2.9 Viewing and changing Occupation Times (Scheduler and Calendar)
      in Saia PCD® Supervisor ...................................................................... 7-16
    7.2.2.10 Viewing a History (Graph) ............................................................ 7-22
  7.3 Manual start the Saia PCD® Supervisor Station .................................... 7-24

A Annex
  A.1 Icons .................................................................................................... A-1
  A.2 Using the Extended Support Options ................................................ A-1
  A.3 Contact ............................................................................................... A-3
0.1 Document History

<table>
<thead>
<tr>
<th>Version</th>
<th>Changes</th>
<th>Published</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENG01</td>
<td>2017-09-05</td>
<td>2017-09-08</td>
<td>- New document</td>
</tr>
<tr>
<td>ENG01</td>
<td>2017-09-26</td>
<td>2017-09-26</td>
<td>- Corrections</td>
</tr>
</tbody>
</table>

0.2 Trademarks

Saia PCD® is a registered trademark of Saia-Burgess Controls AG.

Technical changes are subject to the state of technology.

Saia-Burgess Controls AG, 2017. © All rights reserved.

Published in Switzerland
1 About this Manual

Saia PCD® Supervisor is a supervisor tool for Saia PCD devices. It is based on the powerful Niagara 4.3 software framework and uses the Saia PCD® S-Bus over Ethernet.

This manual describes how to install Saia PCD® Supervisor and configure the SaiaIP-Network to allow Saia PCD devices data to be made accessible to the Niagara framework.

It consists of the following main sections:

2 About Saia PCD® Supervisor
   This section gives an introduction to basic system principles and the Saia PCD® Supervisor user interface.

3 Securing Saia PCD® Supervisor
   This section provides guidance on security issues to be considered when installing and using Saia PCD Supervisor.

4 Installing Saia PCD® Supervisor
   This section describes how to install Saia PCD® Supervisor.

5 Licensing Saia PCD® Supervisor
   This section describes how to obtain and install Saia PCD® Supervisor license files.

6 Creating/Engineering a project
   This section describes the process of engineering Saia PCD® Supervisor.

   6.1 Initial Setup
      This section covers the procedures that must be followed to get Saia PCD® Supervisor ready for use.

   6.2 Manual creation of data points
      This section covers the process to create communicated datapoints manually.

   6.3 Using the “Saia PG5 Data Import Wizard”
      This section covers the process to import the datapoints from the PG5 project using the Saia PCD Data Import Wizard.

   6.4 General functions
      This section describes general function can be used inside of the Saia PCD Supervisor. For example how to configure Saia PCD® Supervisor to control schedules times in the Saia Burgess Controls system.

   6.5 Connect to 3rd Party Systems
      This section covers the process to import the datapoints and communicate with third party Devices. For example BACnet devices.

   6.6 Creating Schematics (Operator Views)
      This section gives basic guidance on creating dynamic operator views that enable end users to navigate and access the system.
6.7 **Set Up for Saia PCD® Supervisor Users**
This section describes how to configure users in Saia PCD® Supervisor to ensure each user only has access to the appropriate information.

6.8 **Backup & Restore**
This section describes how to backup/restore the Saia PCD® Supervisor configuration.

7 **Using Saia PCD® Supervisor**
This section covers general day-to-day operating procedures aimed at end users.

> It is assumed that you understand how to use Niagara 4.3. For further information you should refer to the Niagara documentation which is installed during the Saia PCD® Supervisor installation. It can be accessed from the Saia PCD® Supervisor Help menu.
1.1 Conventions Used in this Manual

There are numerous items and instructions in this manual, the conventions below are designed to make it quick and easy to find and understand the information.

- Menu commands are in **bold** type.
- Buttons, and options in dialogue box that you need to select are in **bold** type.
- The names of text boxes and dialogue boxes are in **bold** type.
- Key combinations that you should press appear in normal type. If joined with a plus sign (+), press and hold the first key while you press the remaining one(s). For example CTRL+S indicates holding down the control key while pressing S.
2 About Saia PCD® Supervisor

Saia PCD® Supervisor is a supervisor tool for Saia PCD Control Systems. It is based on the powerful Niagara 4 software framework. This section describes the key features of Saia PCD® Supervisor and its user interface, and introduces some of the terminology used.

Using the supplied SaiaIPNetwork (SBC Communication Driver), Saia PCD® Supervisor can connect to multiple Saia PCD devices and access device data in order to monitor or adjust the operation. System data is held within a database and is accessible in raw format or presented in specially-designed graphical pages known as schematics or Operator Views (PX view).

Saia PCD® Supervisor connects to the Saia PCD devices network over Ethernet. This gives access to the Saia PCD devices on the associated LAN (Local Area Network) and through S-Bus Gateway functionality serial networked devices.

- Ethernet communication to PCD’s and on PCD’s over RS-485 which are connected behind a gateway.
2.1 Saia PCD® Supervisor Architecture

2.1.1 Platform

In computing, a platform describes some sort of hardware architecture or software framework (including application frameworks), that allows software to run. Typical platforms include a computer’s architecture, operating system, programming languages and related runtime libraries or graphical user interface.

The Platform is the topmost level of configuration and may be compared to the control panel on a PC. In this area of Saia PCD® Supervisor where you can set up:

- Communications
- Install Licenses
- Find fault issues
- Start / Stop stations
- Copy stations
- Backup stations
- Handling certificates
- Handling Lexicons for multilingual projects
- Checking the TCP/IP configuration of the Host computer
- Accessing Remote File system

Access to the Platform requires the user to login, using the same credentials required to login to the Windows PC. In case of some modification Passphrase is also needed.

2.1.2 Station

Software running on a Niagara platform that is the main unit of server processing in the Niagara architecture. A station runs the components of the Niagara framework and provides the access to view and control these components via the Workbench or web browser. Think of the station as the application built by the engineer to integrate the data and design a user interface.

The Station manages communications with the Saia Burgess Controls system(s) and acts as a ‘container’ for all other configuration settings and functions. These include:

- **Services** such as alarm listening and monitoring and the Saia PG5 Data Import Wizard
- **Drivers** for managing access to data in the Saia Burgess Controls system(s) and other systems.
- **Files** schematic/Operator Views used to present system information on remote client devices
- .. many other services are possible
Access to the Station settings requires the user to login (different to platform login). Initial system configuration is achieved using a default admin/engineering user account which is set up when the Station is created. Once configuration is complete further accounts can be added that grant different users specific access rights according their role (see 6.7 Set Up Saia PCD Supervisor Users).

2.1.3 Platform Daemon
A program that is executed as service in the background.

In an other way it is compact executable program that enables a user to access platform tools through the Workbench. The Platform Daemon enables to run the stations on the local PC.

2.1.4 SBCIpNetwork driver
The SBCIpNetwork driver defines the communication settings to a Saia Burgess Controls system and provides access to data held in its controllers and devices, including:

- **Points**: Input, Output, Register, Flag, Timer, Counter, DataBlock and text Block.
- **Histories**: values logged in HD log modules.
- **Alarms**: for monitoring alarm messages generated within the Saia Burgess Controls system.

2.1.5 Other Drivers (open points)
The Saia PCD® Supervisor is based on the Tridium Niagara N4 framework. Therefore it supports a wide range of additional drivers, suitable for interfacing with other manufacturer’s building automation systems and products. This enables the monitoring and control of these systems to be fully integrated with the management of a Saia Burgess Controls system within a common supervisor.

Support for other drivers requires one or more additional open driver packs. For details of order codes and point counts refer to the Saia PCD® Supervisor Data Sheet (34-001_DS_Saia-PCD-Supervisor).

- such an open driver can be: BACnet, Modbus etc.
2.2 User Interface Application (Host PC)

This section introduces the main features of the Saia PCD® Supervisor user interface.

2.2.1 Nav Tree (navigation panel)

The Nav tree (or navigation panel) provides navigation around the elements, folders and files in Saia PCD® Supervisor. It is configurable under “user” by “user”. Once configured, you can view devices and points in a Saia Burgess Controls system.

For help on using the Nav tree, refer to chapter 7.2.2.2 Nav Tree.

2.2.2 Palettes

It is a collection (or library) of components in a hierarchical view that can be copied and pasted where needed – Wire Sheet, Property Sheet, Px View or Palette side bar.

Palettes are useful when configuring certain elements in the system. There are many Palettes available, but the most commonly used in Saia PCD® Supervisor are:

- Alarm ...................... for configuring Alarm handling
- Schedule ..................... for configuring Time Schedules
- History ...................... for configuring Histories (Plots)
- kitControl .................... for creating control logic in Saia PCD® Supervisor
- bajaui........................ for configuring Graphics and accessing default images.
- kitPx.......................... for configuring Graphics and accessing default images.
- kitHVAC ........................ for configuring Graphics and accessing default images.
- kitPxN4Svg .................. for configuring Graphics and accessing default images.
- WebChart ..................... for configuring Graphics and accessing default images.
- SBCOfflineEngineering .... service to import easily resources of a Saia PCD device ........................................ from PG5 project
- sbc............................ for devices and points.
- sbcIconGallery............... for images to build user screens.
• honBACnetUtilities .......... for getting detailed information of BACnet points.

For help on opening and closing Palettes, refer to chapter 7.2.3 Palettes

2.2.3 Locator Bar

There is a fundamental navigation model in the Workbench which is similar to the URL navigation used in the Web browsers.

When the URL is changed the URL referenced content is shown in the browser. A remembered history of the URLs is allowing back & forward navigation.

The ORD (Object Resolution Descriptor) is the universal identification system of Niagara and it is used throughout the Niagara framework. It unifies and standardizes access to all information. And it is designed to combine different naming systems into a single string.

The ORD can be:

  absolute  station:/slot:/Drivers/SBCIpNetwork_Demo/Device1/points/Heating1/Outside/Temperature/PhysVal"

  relative  slot:Outside/Temperature/PhysVal"

The locator bar provides similar functionality to the Nav tree. As you navigate around the file system the locator bar will update to show the current location and view. It shows the ORD (Object Resolution Descriptor)

For help on using the locator bar, refer to chapter 7.2.4 Locator Bar

2.2.4 View Pane & View Changer

The view pane is the principle work space for Saia PCD® Supervisor. When you first run Saia PCD® Supervisor it will display the home page (shown above). As you navigate through the system and select different items in the Nav tree, the view pane will change to show different information or configuration pages.

Some elements may provide more than one type of view. For help on selecting the required view, refer to chapter 7.2.5 View Pane & View Changer
2.2.5 Client Devices

Saia PCD® Supervisor can be accessed via web clients while an IP connection is possible between the client device and the PC running Saia PCD® Supervisor.

Once accessed Saia PCD® Supervisor via Web client, it provides a similar user experience to the user as when it is accessed on the main PC depending on the device being used to access. The Web Server - Client connection can use JAVA or HTML5.
3  Securing Saia PCD® Supervisor

3.1 Introduction

The purpose of this section is to provide the information necessary for those involved in the installation and maintenance of a product or system to understand the requirements for configuring and managing the security of the product or system.


Both documents are available from the Saia Burgess Controls support web site www.sbc-support.com.

3.2 Disaster Recovery Planning

It is a documented process or set of procedures to recover and protect a business IT infrastructure in the event of a disaster. Such a plan, specifies procedures an organization is to follow in the event of a disaster.

When developing the disaster recovery plan ensure that it includes ALL data required to restore system operation, including:

- Configuration files for platform(s) and station(s)
- Database objects
- License and certificate files
- Station Backup
- Station Copies

See chapter 6.8 Backup & Restore for details.

3.3 Physical and Environmental Considerations

The PC running Saia PCD® Supervisor should, where possible, be secured against unauthorised physical access.

3.4 Security Updates and Service Packs

Ensure the PC running Saia PCD® Supervisor and any client devices have the latest operating system updates installed, and the latest version of Saia PCD® Supervisor is being used.

Saia Burgess Controls software is tested against the latest service packs and updates applicable at the time of release. For significant operating system and Java updates / service packs, please check the Saia Burgess Controls support web site www.sbc-support.com for any compatibility issues.
3.5 **Virus Protection**

Ensure the PC running Saia PCD® Supervisor and any client devices are running virus protection software, and the virus definitions are kept up-to-date.

Some virus protection software may have an adverse impact on the performance of Saia PCD® Supervisor. In such cases request that the Saia PCD® Supervisor directory be excluded from on-access scan.

Further details can be found on the Saia Burgess Controls support web site [www.sbc-support.com](http://www.sbc-support.com).

3.6 **Network Planning and Security**

It is recommended that the Ethernet network used by the Building Management System (BMS) is separated from the normal office network using an air gap (separated wiring and devices or layer 3 switches or virtual private network (VPN)). Physical access to the Ethernet network infrastructure must be restricted. You must also ensure that the installation complies with your company’s IT policy.

The use of a firewall and Intrusion Detection System (IDS) from a reputable provider of security products is recommended for any Saia PCD® Supervisor installation. Follow best practice for the products chosen as well as any corporate IT policy where the installation is made. Lock down the products to the particular port you’ve configured for Saia PCD® Supervisor HTTPS and HTTP.

Always follow the guidelines PDF-Documents:

- manual.......................... NiagaraAx Hardening Guide
- instruction.......................... 30-002_Internet-Security-Instructions_SBC
- instruction for using VPN router .. 30-004_VPN-Router

You must also take steps to ensure the security of any other networks connected to Saia PCD® Supervisor (e.g. BACnet).

3.7 **Virtual Environments**

Follow best practice for the products chosen as well as any corporate IT policy where the installation is made.

3.8 **Securing Wireless Devices**

If a wireless network is being used it must be secured according to your company’s IT policy.
3.9 System Monitoring

For any Saia PCD® Supervisor installation, especially when connected to the internet, Saia Burgess Controls recommends the use of an Intrusion Detection System (IDS) from a reputable provider of security products. Follow best practice for the products chosen as well as any corporate IT policy where the installation is made.

Saia PCD® Supervisor logs (Audit History) changes made to its own configuration and adjustments to the Saia Burgess Controls control system. Many IDS and firewall products offer a complete solution for recording all the traffic coming in and out of the Saia PCD® Supervisor PC, providing users with the ability to record all activity at the lowest level.

3.10 Securing Access to the Operating System

Ensure the PC running the Saia PCD® Supervisor and any PCs used for Saia PCD® Supervisor clients are secured according to your company's IT policy.

3.11 Access Control

All Saia PCD® Supervisor files should be protected from read and write access by people and software not authorized. Saia Burgess Controls recommends following best practice for securing system objects, such as files, and using access control appropriately.

If Windows users are granted access to the filing system location of the Saia PCD® Supervisor project then it is possible for them to inadvertently (or deliberately) open, delete or edit any of the configuration and data files of independently of their Saia PCD® Supervisor workgroup settings.

3.12 Securing Saia PCD® Supervisor

The Saia PCD® Supervisor software should be configured during installation and operation following best practice. Follow the installation procedure as described in this manual. In addition, refer to the Niagara 4 help system and Niagara 4 security guidelines.

3.12.1 Default Admin User of a Station

Initial system configuration is achieved using a default admin/engineering user account which is set up with a strong password when a Station is created.
3.12.2 Passphrase

*The passphrase, specified during the Saia PCD® Supervisor installation process, protects sensitive data on any station that you create and will be required if the Saia PCD® Supervisor station is to be moved to another PC e.g. moved to the site PC, or restored after a PC failure.*

3.12.3 Set up Other Users for the Station

Once configuration is complete (using the default admin user) further user accounts must be added that grant different users specific access rights according their role. Saia PCD® Supervisor enforces the use of strong passwords.

For further details, see chapter 7 Using Saia PCD® Supervisor

3.13 Saia PCD® Supervisor Security Check List

- Latest version of Saia PCD® Supervisor is being used.
- Saia PCD® Supervisor installation files, configuration files (including station backup), certificates and licenses are included in disaster recovery plan.
- The PC running Saia PCD® Supervisor should, where possible, be secured against unauthorized physical access.
- The Ethernet network (and any other networks) that the PC is connected to is secured, e.g. by the use of firewalls and intrusion detection systems.
- The PC is running the latest version of the Windows operating system, with all updates and service packs.
- The PC is running virus protection software.
- Appropriate user accounts are set up on PC and access to files is restricted to only those who are authorized.
- Saia PCD® Supervisor is configured to use HTTPS using a certificate from a trusted Certificate Authority.
- Saia PCD® Supervisor users are configured as required.
- Ensure Saia PCD® Supervisor is configured to backup data regularly to a secure location as per your company’s backup policy.
4 Installing Saia PCD® Supervisor

This section describes how Saia PCD® Supervisor should be installed to ensure that it operates correctly. The following steps are required to install Saia PCD® Supervisor:

4.1 Installation Requirements

4.2 Obtaining the Saia PCD® Supervisor Software

4.3 Installing the Saia PCD® Supervisor Software

4.4 Installing the Platform Daemon

4.5 Configuring the Windows Firewall
4.1 **Installation Requirements**

Before installing, or upgrading, ensure that the PC meets the system requirements. Refer to the Saia PCD® Supervisor Data Sheet (34-001_DS_Saia-PCD-Supervisor).

The PC on which Saia PCD® Supervisor is to be installed must have TCP/IP access to the Saia Burgess Controls network.

4.2 **Obtaining the Saia PCD® Supervisor Software**

Navigate to the Saia Burgess Controls Technical Support web site at [http://www.sbc-support.com](http://www.sbc-support.com) --> Software / Saia PCD® Supervisor
4.3 Installing the Saia PCD® Supervisor Software

1. Log in to the PC as someone with Administrator rights.
   
   *It is recommended that you close all other programs before installing Saia PCD® Supervisor. However, do not close any virus protection software.*

2. Presently the installer works from the local hard drive only. Therefore the installer must be copied to a local folder first (e.g. C:\Temp)

3. Run ‘Installer_x86.exe’ (for 32-bit operating systems) or ‘Installer_x64.exe’ (for 64-bit operating systems), and wait for the first installation screen to appear.

4. Follow the on-screen instructions
Read and accept the license agreement.

5. Change the destination folder (if required). The default path is "C:\SBC\SaiaPCDSupervisor".

   *If you enter a new path it must not contain spaces*
6. Add shortcuts to the Start Menu and Desktop.

7. Once the installation is complete the following screen is displayed.
During the installation you will be prompted to create a passphrase which ensures sensitive data on any station that you create is protected. Ensure that you remember it and keep it safe as it will be required to move the configured Saia PCD® Supervisor to another PC.

Leave all three check-box checked and click the Finish button. Then the software is installed and two icons are placed to the Desktop.

4.4 Installing the Platform Daemon

If there are other instances of Saia PCD® Supervisor (or Niagara) on the same PC then the Platform Daemon must be installed. This will typically be set up during the installation process. It can also be installed and run manually.

1. Click Start and choose All Programs.
2. Navigate to the Saia PCD Supervisor folder.
3. Click Install Platform Daemon.

After a few seconds a command window should briefly appear with the following message:

To check if the Platform Daemon is already running go to:
Windows Control Panel → Administrative Tools → Services → Niagara Services running

The running Niagara service can block communication ports depending on what type of communication is configured.

4.5 Configuring the Windows Firewall

You may need to configure the Windows Firewall to allow Saia PCD® Supervisor to communicate correctly.

To configure the Windows Firewall

1. Open the Windows Firewall.
   - In Windows 10 or 8, type ‘Windows Firewall’ in the Search box
   - In Windows 7, click the Windows Start button, type ‘Windows Firewall’ in the Search box.
   - Click Windows Firewall from the list of search results.
2. Click Allow a program or feature through Windows Firewall. The Allowed pro-
3. Scroll down the list and check that entries exist for Niagara Runtime Launcher, Niagara Station Launcher, and Niagara Workbench for your Saia PCD® Supervisor installation folder. If these programs do not appear in the list you will need to add them (see procedure below).

   Each installed instance of Niagara requires its own entries in the Firewall settings.

4. If you need to change any settings click Change settings and edit the checkboxes as required.

   To add programs to the firewall:
   1. Open the Allowed programs and features list as described above.
   2. Click Change settings.
   3. Click Allow another program. The Add a Program dialogue box is displayed.

   4. Click Browse and navigate to the Saia Burgess Controls Control Systems | Saia PCD Supervisor | bin folder.
   5. Double click the program to be added.
   6. To add Niagara Runtime Launcher select nre.exe
7. To add Niagara Station Launcher select `station.exe`.
8. To add Niagara Workbench select `wb_w.exe`.
9. The program will appear highlighted in the **Add a Program** dialogue box. Click **Add** to add the program to the firewall list. The dialogue box will close.
10. Repeat steps 3 through 6 to add the other programs.
5 Licensing Saia PCD® Supervisor

Before Saia PCD® Supervisor can be used, it must be licensed. The license will allow you to run the application on a single PC.

5.1 Obtain a Saia PCD® Supervisor License and Certificate

When an unlicensed installation of Saia PCD® Supervisor is run you will be prompted to email certain details to Saia Burgess Controls in order for them to provide the relevant license and certificate files.

To obtain a license:
1. Launch the Saia PCD® Supervisor application, e.g. from the Start menu point to All Programs > Saia Burgess Controls Systems > Saia PCD® Supervisor and then click Saia PCD® Supervisor. The Request License dialogue box is displayed. The pop up pictures shows you the so called Host ID of the computer. The Host ID is strictly connected to that hardware of the PC. If the hardware is changed a new license must be obtained.

2. Email the requested information (list what is required…) to your local sales office including the email address you would like the license files sent to.

3. Click Exit to close the dialogue box.

The Order Management Team will process your request, and email the license and certificate files to the specified email address.

5.2 Install the Saia PCD® Supervisor License

Your Saia PCD® Supervisor license is mailed to you as a ZIP file containing a number of license and certificate files which need to be installed on the PC containing Saia PCD® Supervisor, this can be done in two ways:

5.2.1 Automatic Licensing

5.2.2 Manual Licensing
5.2.1 Automatic Licensing

Saia PCD® Supervisor can be licensed automatically via the global license server providing the PC has internet access. If this is the case when Saia PCD® Supervisor is run after your license request has been processed it will automatically be licensed and the files copied to the required folder.

5.2.2 Manual Licensing

To install the license and certificate files:

1. Copy the ‘Licenses.zip’ file to the PC hard disc.
2. Extract all the files from ‘Licenses.zip’ to an empty folder. The folder should now contain six files.
3. Copy the three ‘.license’ files to the “C:\SBC\SaiaPCDSupervisor\security\licenses” folder.
4. Copy the three ‘.certificate’ files to the “C:\SBC\SaiaPCDSupervisor\security\certificates” folder.
5. You will now be able to launch the Saia PCD® Supervisor (Workbench) application.

5.3 Updating a License

If you purchase a license upgrade, e.g. for additional points, you will be emailed the updated license files as a ZIP file containing a number of license and certificate files and it will be necessary to upgrade the Saia PCD® Supervisor license. If the Saia PCD® Supervisor PC PC is connected to the internet this should happen automatically - see chapter 5.2.1 Automatic Licensing, alternatively the files can be copied manually - see chapter 5.2.2 Manual Licensing.
Creating/Engineering a project

Building a site within Saia PCD® Supervisor involves creating a database that reflects the structure, devices and points within the associated Saia Burgess Controls system. In the Saia Burgess Control System mainly the S-Bus communication protocol is used. However it is possible to use third party communication protocols depending on the used license. A Point in the Saia PCD® Supervisor represents a value or state of an item in the Control System (e.g. a point represents a value or state of a symbol from the PCD controller).

For example: “Outside_Air_Temperature_Sensor_Value” is the point name in the Saia PCD® Supervisor, but it is actually communicated as “Register 100” from the proper PCD device.

The communication connection is based on Media type and Media address (“Register 100”) not on the symbol name.

There are two methods to build up the point database within Saia PCD® Supervisor:

- Manual creation of data points
- Using Saia PG5 data import wizard

You can use either one or both methods to build up your point database, according to your requirements.

It is the best practice to only add the points required for use in the Saia PCD® Supervisor. Adding unwanted points will increase the memory usage and affect the remaining license count. Keep in mind that the points for HDLogs are imported to get it working properly.

Go to ..

6.1 Initial Setup
6.2 Manual creation of data points
6.3 Using the “Saia PG5 Data Import Wizard”
6.4 General functions
6.5 Connect to 3rd Party Systems
6.6 Creating Schematics (Operator Views)
6.7 Set Up Saia PCD® Supervisor Users
6.8 Backup & Restore
6.1 Initial Setup

When Saia PCD® Supervisor is run for the first time you will need to work through an initial setup procedure which involves the following steps:

6.1.1 Launch the Saia PCD® Supervisor Application

1. Click Windows Start button and choose All Programs.
2. Navigate to the Saia PCD Supervisor and open it.
3. Click Saia PCD Supervisor. The Saia PCD® Supervisor application window will be opened. This program is called as Workbench in relation of Niagara N4 environment. (It can happen that the start of the program takes a bit more time, please be patient.)

6.1.2 Open the Platform

1. In the Nav tree of the Saia PCD® Supervisor tree right-click on MyHost and choose Open Platform. The Connect dialogue box is displayed.
2. In the **Type** box select **Platform TLS Connection**. Leave other settings at their default values.
3. Click OK. The **Authentication** dialogue box is displayed.

   ![Authentication Dialogue Box]

   If a ‘Cannot display page’ error appears, ensure that the **Platform Daemon** has been installed. See chapter "4.4 Installing the Platform Daemon".

4. Enter the **Username** and **Password** that you would normally use to login to the Windows PC.

   ![Platform Dialog Box]

   For security it is recommended that the **Remember these credentials** box is left unchecked.

5. Click OK.

   A “Platform” item will now appear in the Nav tree and various platform objects will appear in the view pane.
6.1.3 Create a New Station

1. From the Tools menu select New Station. The **New Station Wizard** is displayed.

2. Under Station Templates click SaiaPCDSupervisor.ntpl to highlight it.

3. Type a suitable name in the Station Name box.

   *If a station already exists with that name you will be prompted to delete the existing station or you can go back and specify an other name for your new Station. You must select Yes to proceed.*
4. Click Next.

5. Type a password in the Password for admin User box.

   The password must have a minimum of 10 characters and include at least one capital letter, one lowercase letter and one numeral (digit).

   As example:
   
   username: admin  
   password: Manager123  (it can be later changed)

6. Retype the password in the Confirm Password for admin User box.

   This password is for the ‘admin’ and should be reserved for engineers. It grants access to everywhere and to everything inside of a Station.

7. Select the copy it to secure platform for “localhost” with Station Copier option.

8. Click Finish.

9. If you have not already logged in to the Platform the Authentication dialogue box is displayed, go to step 10
Creating/Engineering a project

Initial Setup

If you have already logged into the Platform, go to step 11.

10. Enter your Username and Password (login credentials of the PC) and click OK.

11. If a station with the same name already exists, you will first be prompted how to proceed.

12. Specify the required option.

13. Click Next. A dialogue box enabling you to specify the start-up options is displayed.

14. Select the required start-up options.

- **START AFTER INSTALL** Select this option if you want to start the station as soon as it has copied (recommended).
- **AUTO-START** Select this option if you want the station to be started when the PC is restarted (recommended).

When developing several Supervisors other stations will need to be stopped.

15. Click Next.
16. Click Finish. A progress update is displayed.

17. When the process is complete, click Close. The Open Application Director dialogue box is displayed.

18. Click Yes. The Application Director is displayed. Check that a 'Station Started' message is shown.
6.1.4 Open the Station

1. In the Nav tree right-click on MyHost and select Open Station. The Connect dialogue box is displayed.

2. In the Type box select Station TLS Connection. Leave other settings unchanged.

3. Click OK. The Authentication dialogue box is displayed with the default ‘admin’ user selected.

4. Type the appropriate password in the Password box (i.e. the password specified when the Station was created).

   For security it is recommended that the Remember these credentials box is left unchecked.

5. Click OK
6. After a short delay, the chosen station name will appear in the **Nav** tree and the view pane will show a summary of Station parameters (Station Summary view):
6.2 Manual creation of data points

This chapter describes the manual creation of the point database.

The following steps are needed to create the data point:

1. Add a Saia Burgess Controls Driver (it is named as “sbc” in the Palette)
2. Configure the driver
3. Add device(s) manually (mainly PCD or other S-Bus communicating devices)
4. Add the required points to the database. Take care of the conversion. Building automation mainly using integer numbers multiplied with factor 10 in the PCD controller. While Saia PCD® Supervisor is using normalized floating point.
5. Check (or modify if necessary) the speed of the communication of the point

This is a tedious process with the possibility to make mistakes easily. However it is advantageous for every System Integrator to understand the process.

It makes sense to arrange a PCD controller - connected to Saia PCD® Supervisor - with a simple user program to follow up the explanation.

The user program can be for example a simple PCD device with media mapped PCD3.S100 Workshop Simulator Unit. (Who does not understand this sentence please go through the SBC PG5 User Manual or better to take part of a Basic SBC PG5 workshop.)

Important: The communication connection is based on “Media type” + “Media Address” (e.g. Register 100). Best practice is to use explicit addressing (so called “hard addressing”) in the PCD controller. Dynamic addressing can be also used (makes no so much sense) but the System Integrator must understand, that the dynamically allocated addresses in the PG5 can be any time overwritten by the PG5 programming tool.

6.2.1 Add a Saia Burgess Controls driver (SBCIpNetwork)

We need to define at least one SBCIpNetwork for S-Bus over Ethernet communicated devices. Under the SBCIpNetwork driver many PCD devices can be configured to communicate with. It is possible to define other SBCIpNetwork networks in order to distribute the PCD devices better and decrease the load of each SBCIpNetwork.

The Saia Burgess Controls Driver controls the communications and flow of data to and from the PCD devices.

It is possible to communicate with serial S-Bus networked devices using the SBC S-Bus gateway function in the PCD controllers.

On larger sites it may speed up data transfer to utilise two or more separate SBC S-Bus drivers (SBCIpNetwork)
6.2.1.2 Create a folder for Saia Burgess Controls Driver

1. In the Nav tree open the Station folder.

2. Open the Config folder.

3. Right-click on Drivers and select New > Folder. The Name dialogue box is displayed.

   ![Name Dialogue Box]

4. Type SBC and click OK. The new folder will appear in the Nav tree.

5. Right-click the SBC folder and select Rename. The Rename dialogue box is displayed.

   ![Rename Dialogue Box]

6. Type SBC Systems and click OK.
6.2.1.3 **Add the Saia Burgess Controls Driver**

1. In the Nav tree open the Station folder.
2. Open the Config folder.
3. Double click on Drivers. The view pane will show a list of installed Drivers (Driver Manager).
4. Click on the New button. The New dialogue box is displayed.

5. In the Type to Add box select ‘**SBCIpNetwork**’.
6. Click OK. The following dialogue box is displayed:

![Image of New dialogue box]

7. Change the default network Name to be a meaningful name for the site.

   *This can be renamed later by right-clicking the driver in the Nav tree and selecting Rename.*
8. Click OK. The Driver Manager will now show the Saia Burgess Controls driver.

9. Right-click the driver and select Cut.
10. In the Nav tree, right-click the SBC Systems folder and select Paste.

![Image showing the navigation tree with SBC Systems folder highlighted]

It is possible to create folder to the points to make nicer structure. However when the Saia PG5 Data Import Wizard is used the default SBCIpNetwork folder is generated. This folder can be renamed. The next import then will be done to the renamed folder. The target folder of the import cannot be freely chosen.

11. In the Nav tree, right-click to the SBCIpNetwork_Demo in the SBC Systems folder.

12. You now need to configure the communications of (each - if you have many) Saia Burgess Controls Driver.
6.2.2 Configure the Saia Burgess Controls Driver(s)

Saia PCD® Supervisor connects to the Saia Burgess Controller network (Ethernet networked PCD devices) using S-Bus over Ethernet communication. It is necessary to configure Saia PCD® Supervisor with the IP Address (or hostname) and the S-Bus station address of the device to communicate with. Inside of the PCD device the Media can be addressed by specifying the type and memory slot.

At this point it is recommended to have a SBC PCD device (a controller with the correct application running inside, with the correct Ethernet parameters set in the PCD and also in the PC) connected to the Saia PCD® Supervisor.

In the Nav tree right-click on the Saia Burgess Controls driver (e.g. SBCIpNetwork_Demo) and choose Views > AX Property Sheet. The view pane will show a list of driver properties:

![AX Property Sheet](image)

Basically the default parameters are good for starting.

The driver must be enabled. Status must be OK. It can happen that the status at the beginning is “down” it will be “ok” right after the communication is established with the SBC Device.
6.2.3 Adding Device to the Saia Burgess Controls Driver(s)

Each physical networked SBC controller needs at least one PCD (device) added to the Saia Burgess Controls Driver (SBCIpNetwork_Demo) with unique name.

1. Open the Palette sidebar if it not yet opened.
   
   Menu bar → Window menu → Sidebars → Palette

2. Open the “sbc” palette.

3. Copy PCD from palette. Right click to PCD and select copy.

4. Right mouse click to the driver “SBCIpNetwork_Demo” and paste it.

5. Name it as Device1 (- or CPU1 - or respectively to the app running in the device e.g. AHU1 as Air Handling Unit 1).
6. Double click to the Device 1 will bring up the following screen.
7. Setup the IP address and the S-Bus Station ID of the Device 1
   The Device1 must be enabled.
   Keep the default parameters in.

   ![Property Sheet]

   The FTP credentials and HTTP password need to be manually configured here. If these credentials are missing, then the HDLog and Alarm data retrieval are not working.

   The status can be OK or Down. When it is OK the communication is well established. When it is down it can happen that he initial telegrams were not correct answered (wrong IP or S-Bus station number). Check and correct - if needed - the settings. Save the settings. Press the Refresh button at the bottom of the page.

   Disable the Device and save the settings. Enable the Device and save the settings. These actions are initiating telegrams which must be answered by the Device. Navigate to the Device Information. This will surely initiate telegrams to be sent
in order to get back the basic information of the connected Device. After that the “Status” of the Device must be OK. If not the parameter settings is not correct, or the Device is not correctly connected to the network. Try to ping the Device (keep in mind that the Windows firewall can block the ping). Step by step check of the settings in the SBC Device and also in the Saia PCD® Supervisor is needed.

Last step is to restart the Platform Daemon,
See chapter **4.4 Installing the Platform Daemon**
6.2.4  Add Points to the Device to get the data from the PCD

First of all it is not possible to “Discover” the points from the PCD device.

The points must be added manually.

Let us create a “SBCRegister” and some “SBCFlag" type of points.

1. Navigate to the Points folder of the Device1. It is empty.

2. Navigate to the Palette → sbc → Points. In this folder there are templates for every each possible type of points. This means these type of variables can be found inside of the SBC Device depending on the user program. The template points are nicely colored so it is easy to distinguish the different types.

3. Drag the “SBCRegister” type from the Plaette “sbc" and drop it to the Device1/ Points folder. In the pop-up window name it “AnalogInput_1”

I name it like that because I would like to connect here the physical analogue input 1 of the PCD3.S100 workshop module. Of course there is a corresponding program downloaded to the PCD device.
4. The address has to be set for that point. I know that the first analogue input of my Device is mapped to the Register 100. (In this application this is a potentiometer of the PCD3.S100 simulator unit)

1. So double click to the AnalogInput_1.
2. Open the Proxy extension.
3. Setup the Memory Address to 100.
4. Data Format can be as it was “Signed Integer”.
5. Save it.

5. The Status must be {ok}. It can be seen that the “Read Value” and the “Out” are following the content of the “Device1/Register 100”.
6. The Conversion is set automatically to 0.1. The **Conversion** is set to **Linear** and the **Scale** is set to **0.1**. This will remove the 10 multiplication factor we use conventionally in the Building Automation. This scaling can be seen on the “Read Value” and the “Out”.

It is possible to set the Engineering Unit, precision, and the limits of the value, in the **Facets**.

7. For the SBCFlag types. Copy the “SBCFlag” type of point from the Palette. Right click to the Device1/Points folder. Select “Paste Special”.
8. In the pop-up set the “Number of copies” to 8. Other settings must be untouched.

![Paste Special dialog box]

9. 8 points are generated with the name “SBCFlagx”

10. I want to change the names of the generated points. Select the points. Right click to the selection. Select rename from the context menu. Fill up the “Search for” and the “Replace with” fields. Press ok.

11. Right click to the “Points” folder of the Device1 ➔ Views ➔ AX Property Sheet

12. Setup the address of each “DigitalInput_” points.
13. The Status must be {ok}. The “Read Value” and the “Out” of the generated points are following the content of the Flag 100 to 107 of the Devcie1.

The same way it is possible to create every needed points and connect it to the corresponding media element of the SBC PCD device.

Remember that Saia PCD® Supervisor is licensed for use up to a specific number of points. It is good practice to only add points that are actually required. Adding points that won’t be used by Saia PCD® Supervisor will not only waste resources but also generate unnecessary extra network traffic.

6.2.5 Add Alarming to a data point in the Saia PCD® Supervisor

In the Saia PCD® Supervisor there is an Alarm Service which can be used to set Alarms for individual datapoints, regardless if the datapoint is considered alarm or not at the start of the engineering.

For example the Outside Air Temperature can generate an alarm when it goes under –20°C. For that we need to set the monitoring in the Saia PCD® Supervisor. So the Alarm is generated in the Saia PCD® Supervisor not in the PCD controller.

There is an other way of alarming, which is described in details later in this manual. The Alarms are generated in the PCD Device and the Saia PCD Supervisor takes these alarms over.
6.2.5.1 Steps to set alarming to a datapoint

1. In the Nav tree open the 127.0.0.1/Station(Demo_Station)/Config/Services folder. And double click to the AlarmService.

The default view (Wire Sheet) will be displayed with the default settings. (Alarm Db Config, Default Alarm Class and the Console Recipient).

The Default Alarm Class is already used for system alarms (for those alarms which is generated in the Saia PCD® Supervisor). Most of the cases we do not want to see the Supervisory system generated alarms together with the alarms which is coming from the controlled process. So we need a new alarm class to be placed.
2. Place a new alarm class to the Wire Sheet from the palette. It can be named as you see fit. (here it is named Critical Alarms)
3. There Console Recipient is already placed. It is possible to use this recipient (re-
name it to proper name) or place a new one.

*This Console Recipient is coming from the SaiaPCDSupervisor.ntpl template file.*

The alarm console is one way to inform the User about alarm occurred in the sys-
tem. There can be other way like sending E-mail or SMS.

4. Wire the Alarm console and the Alarm Classes together as the next image shows.
The system has to know what to do with the alarms so that the Alarm Classes
(container of alarms) and the Alarm Console (a way to display them) has to be con-

5. Copy the BooleanChangeOfStateAlarmExt from the Palette / Alarm / Extensions
to the data point where alarm has to be added. (Boolean datapoint called: Points/Heating1/Supply/Pump/Alarm)

In the pop-up Name field give a proper name (or just leave it default)
6. Set up the properties of the Alarm Extension
   
   **Alarm inhibit** = false
   
   **Alarm Enable** = x to Offnormal ; o to Fault

![Diagram of Saia-Burgess Controls AG PCD Supervisor showing property sheet for Alarm extension with Boolean values](image-url)
### Manual creation of data points

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm inhibit</td>
<td>True/false</td>
<td>Alarm is activated / deactivated</td>
</tr>
<tr>
<td>Inhibit Time</td>
<td>hours / minutes / seconds</td>
<td>Stages of the alarms</td>
</tr>
<tr>
<td>Alarm state</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Fault</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- offNormal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Normal</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Fault: value is invalid e.g hardware fault</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- offNormal: value is valid but out of the its borders</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Normal: value is valid and inside of the border.</td>
</tr>
<tr>
<td>Time Delay</td>
<td>hours / minutes / seconds</td>
<td>Delay before alarm is generated</td>
</tr>
<tr>
<td>Time Delay To Normal</td>
<td>hours / minutes / seconds</td>
<td>Delay before alarm state goes away (if the alarm in the corresponding device is already cleared)</td>
</tr>
<tr>
<td>Alarm Enable</td>
<td>ToOffNormal / To Fault</td>
<td>Enables the Alarm stages to be monitored</td>
</tr>
<tr>
<td>To Offnormal Times</td>
<td>Alarm Timestamp</td>
<td>The details of the last occurred offNormal alarm</td>
</tr>
<tr>
<td>To Fault Times</td>
<td>Alarm Timestamp</td>
<td>The details of the last occurred Fault alarm</td>
</tr>
<tr>
<td>Time in the Current state</td>
<td>hours / minutes / seconds</td>
<td>The elapsed time since the state was changed</td>
</tr>
<tr>
<td>Source name</td>
<td>%parent.display-Name%</td>
<td>It takes the name from the parent object name.</td>
</tr>
</tbody>
</table>
7. Set up additional parameters

To Fault Text – Pump fault (it is unchecked, we do not have info if the value is reliable or not. If there is communication error between the Saia PCD® Supervisor and the PCD device then the state will be different)

To Offnormal Text = Pump Error (this will be the alarm)
To Normal Text = Pump OK (text when the alarm leaves)
Offnormal Algorithm / Alarm value = true
Alarm Class = Critical Alarm class (created earlier)
## Manual creation of data points

<table>
<thead>
<tr>
<th><strong>Property</strong></th>
<th><strong>Value</strong></th>
<th><strong>Meaning</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>To Fault Text</td>
<td>Any text which refers to the state</td>
<td>User defined / can be seen in the Alarm Console</td>
</tr>
<tr>
<td>To Offnormal Text</td>
<td>Any text which refers to the state</td>
<td>User defined / can be seen in the Alarm Console</td>
</tr>
<tr>
<td>To Normal Text</td>
<td>Any text which refers to the state</td>
<td>User defined / can be seen in the Alarm Console</td>
</tr>
<tr>
<td>Hyperlink ORD</td>
<td>ORD, BQL Query or path</td>
<td>When an alarm is reported in the console, the Hyperlink button activates. Clicking this button links to the location you specify here.</td>
</tr>
<tr>
<td>Sound File</td>
<td>Path text</td>
<td>Path of the sound file for audible alarm.</td>
</tr>
<tr>
<td>Alarm Icon</td>
<td>Path text</td>
<td>Path of the picture which is displayed in the “timestamp” column in the Console Recipient view.</td>
</tr>
<tr>
<td>Alarm Instructions</td>
<td>Instruction text</td>
<td>It is possible to define instructions what to do when alarm occurs.</td>
</tr>
<tr>
<td>Fault Algorithm</td>
<td>Fault Algorithm</td>
<td>Algorithm to generate alarm on Reliability of the associated point. This property when available, displays fault parameters. Different options are available here, depending on the alarm extension being used.</td>
</tr>
<tr>
<td>Offnormal Algorithm</td>
<td>Boolean Change Of State Algorithm</td>
<td>Algorithm of generating the alarm. Inside it is possible to set parameters to define the way of the alarm generation</td>
</tr>
<tr>
<td>Alarm Class</td>
<td>Any proper Alarm Class</td>
<td>Which Alarm Class is used to collect the alarm</td>
</tr>
<tr>
<td>Meta Data</td>
<td>Text</td>
<td>Allows you to enter new facets for the extension.</td>
</tr>
</tbody>
</table>
8. Open the Alarm console (double click on it). It is possible to check the behavior of the Alarming of the Points/Heating/Supply/Pump point.

When new alarm comes there is an audible sound to indicate it. This feature can be deactivated with the Silence button.

The Alarm can be Acknowledged, the list is updated accordingly.

It is possible to add notes to the alarm stored in the Saia PCD® Supervisor.

Possible to define filter the Alarms, for example filter only the Alarms which is relevant to the operator sitting front of the screen.
6.2.6 Add History to a data point in the Saia PCD® Supervisor

In the Saia PCD® Supervisor there is a History Service which can be used to set history log for individual datapoints.

For example the values of the Outside Air Temperature can be logged (history) then later the logged values can be displayed as trend curve or just a plain text table with the values in time order. It is also possible to export the values (in a defined time span) to external file.

There is another way of logging the history, which is described in details later in this manual. The histories (called HD Logs) are generated in the PCD Device and the Saia PCD Supervisor appends the content to history files located in the Saia PCD Supervisor.

6.2.6.1 Steps to setup History for a datapoint in the Saia PCD® Supervisor

1. Check the History Service in the Services folder of the Station
2. Open the history Palette and copy the NumericInterval extension to the datapoint called Points/Heating1/Outside/Temperature/PhysVal.

In the pop-up window it is possible to rename the extension to a suitable name.

It is also possible to choose other type of history, for example Numeric COV or Boolean Interval etc. Please check the different type of History Extensions in the Niagara documentation.
3. setup the parameters of the NumericInterval extension.

- **Enabled** = True
- **History name** = %parent.parent.parent.name%_%parent.parent.name%_%parent.name%
- **Interval** = 1 min

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Enabled/Disabled</td>
<td>Show if the history is enable or not. It is always disabled after configuration. The user has to enable it.</td>
</tr>
<tr>
<td>Fault Cause</td>
<td>Any kind of system generated fault</td>
<td>Error occurred during History creation. For example the name of the history is too long (more than 67 chars)</td>
</tr>
<tr>
<td>Enabled</td>
<td>true / false</td>
<td>Switch to Enable / Disable the history of that point</td>
</tr>
<tr>
<td>Active period</td>
<td>Days of Week / Time range</td>
<td>Possible to schedule when the historization of that datapoint should be switched on</td>
</tr>
<tr>
<td>History name</td>
<td>Defined name of the history</td>
<td>It is possible to give name to the history or generate the name from the datapoint name. For example: %parent.parent.parent.name%_%parent.parent.name% will generate the following name Outside_Temperature_PhysVal</td>
</tr>
<tr>
<td>History Config ..</td>
<td>Summarized settings of the History</td>
<td>It is possible to navigate one step down and modify the settings in detail.</td>
</tr>
<tr>
<td>.. ID</td>
<td>ID of the History</td>
<td>Generated by the system, should be unique.</td>
</tr>
<tr>
<td>.. Source</td>
<td>Source of the History</td>
<td>The full ORD of the history.</td>
</tr>
</tbody>
</table>
Creating/Engineering a project

Using the “Saia PG5 Data Import Wizard”

|.. Time Zone | Time zone | The configured time zone of the PC where the Saia PCD® Supervisor is running |
|.. Record type | Record type | It is preconfigured in the Palette / Extensions |
|.. Capacity | Record count / Unlimited | The number of the records allowed to create / unlimited. It depends where the History is created. Limited size of memory device can be used to store the History. |
|.. Fill policy | Roll/Stop | Roll – the oldest history will be overwritten with the newest log Stop – when the record count is reached the logging is stopped |
|.. Interval | Interval of the logging | It is possible to setup the interval between two logs creation. |
|.. System Tags | e.g.: NorthAmerica; Region1; Cities. | This property allows you to assign additional metadata (the System Tag) to a history extension. |
|.. minRolloverValue | number | It takes over the settings from the same property below. |
|.. maxRolloverValue | number | It takes over the settings from the same property below. |
|.. precision | 32 bit / 64 bit | It takes over the settings from the same property below. |
|.. valueFacets | e.g.: units, precision, min, and max. | Facets contain additional data applied to input and output values. |

Last Record Date and time The date and time of the last value is stored.

Interval Interval of the logging Same as above: It is possible to setup the interval between two logs creation.

Precision 32 bit / 64 bit The same as above: Precision of the floating point value which is used for that history.

Min Rollover Value number Related parameter for "Delta" logging for e.g. electric consumption for displaying the difference not the absolute value. It is valid for NumericChangeOf Value and for Numeric Interval. See Niagara documentation.

Max Rollover Value number Related parameter for "Delta" logging for e.g. electric consumption for displaying the difference not the absolute value. It is valid for NumericChangeOf Value and for Numeric Interval. See Niagara documentation.

4. Save the settings
5. The following History is created

6. Double click to the name of the History

The Chart of the logged values will be opened.

Additional features can be checked in the Niagara documentation.
6.3 **Using the “Saia PG5 Data Import Wizard”**

The import wizard an offline add-on tool to import the symbols from one or more SBC PCD device(s) to the Saia PCD® Supervisor point database. The Import Wizard is integrated into the Saia PCD® Supervisor (it is not a standalone tool). The Import Wizard gives the possibility to import the “symbols” from one or more SBC PG5 project, which can content of course many PCD devices per each.

The symbols, to be imported, can be filtered by type, by name.

The symbols can be re-imported any time or after modification has been done in the PG5 project. User can decide if the imported symbols are overwriting the points in the Saia PCD® Supervisor, or not.

The import procedure can be cancelled and new-started any time.

During import an error check is done, which ensures that only the good formed symbols are imported. The absolute necessity of using unique point names are ensured through the PG5 symbol table. The PG5 project can be buildable if the symbol table is correct. The downloaded PG5 program and the Saia PCD® Supervisor imported points must be all the time consistent.

When symbols from multi project are imported the System Integrator must make himself sure, that there no the very same named symbols (points) are getting imported. For example there are two PG5 project created, one is called Building_A and the other Building_B. Inside of both projects there are PCD devices called CPU1, CPU2, CPU3. This happens because the Building_B project is just a copy of Building_A project. Let us assume that the Building_A project has been already done. During import of the Building_B project e.g. the CPU1 symbols from Building_A are getting overwritten while the symbol name structure are the same in both projects. To avoid such a situation it is recommended to have a unique ID for each PCD device in the projects to be imported. Or use dedicated “Saia Burgess Controls Driver” for each PG5 project.

The points in the Saia PCD® Supervisor point database are structured hierarchically according to the symbol groups in the symbol table of PG5 project.

The following different type of symbols and other information/data can be imported from a PG5 project to the Saia PCD® Supervisor point database.

1. PG5 symbols or datapoints
2. Alarm list generated in the PG5 project
3. Historically logged data so called HD Logs.

*Only SBC Web-Editor 8 generated Alarm lists are supported. SBC DDC Suite based alarms are not supported. Before importing the Alarm list and the HD Logs the web project in the Web-Editor 8 must be compiled. Take care to select the language for the Alarm list before compile in the Web-Editor 8. The up to date configuration files (csv files) must be available for import.*
6.3.1 Preparation

For importing the Symbols from PG5 project we need to use the Saia PG5 Data Import Wizard tool.

The “Saia PG5 Data Import Wizard” is installed together with Saia PCD® Supervisor.

It is a fact that the PG5 project (the program of the PCD controller) – from where the symbols, to be imported - is developed in a completely different tool, and this tool is not integrated presently in any way into the Saia PCD® Supervisor. Due to this fact at the beginning the Saia PCD® Supervisor has no information about the PG5 project and its symbols.

It is needed to copy the actual up to date and compiled PG5 project under to the Station where it will be used.
Typical shared folder of a station would be like this:

C:\ProgramData\Niagara4.3\SBC\stations\Demo_Station\shared

So the complete PG5 project has to be copied there.

The copy procedure has to be repeated at each time when modification was made. (When compile of the PG5 project was happened, so the content of the symbol table could have been changed).

Naturally when the symbol table is changed, it is necessary to re-import the symbols from the PG5 project to the Saia PCD® Supervisor point database.

*During new import the Saia PG5 Data Import Wizard will retain all user defined configuration of a datapoint, except memory address and comment. User can choose to overwrite comment or address&comment during the process.*
6.3.2 Importing symbols from PG5 projects

For importing symbols from the PG5 project the “Saia PG5 Data Import Wizard” has to be started. This tool will do an offline symbol import. When the symbols are imported to Saia PCD® Supervisor then we can call them "Points". Discovery of the symbols in the SBC PCD device and do online symbol import is not possible.

1. Double click to the Saia PG5 Data Import Wizard under the currently used Station. The Wizard opens.

   At the beginning nothing is selected.

2. Chose the right PG5 project. Click to the “File” button and select the PG5 project file of the project copied to the shared folder of the Station. Press OK.
3. Check the datapoints and press Scan

At this window press Proceed

*It is possible but please try to avoid accented or special characters.*

Not supported characters $,# and %.

*For others proper code page has to be selected then they are correctly visible.*

4. The amount of the possible symbols are calculated. Press Next.
5. The symbol list is populated.

The top of the Wizard window can be seen that the procedure is at the stage of datapoints.

The left side of the Wizard window the found Devices with the symbol groups of the selected device. There is also a filter icon which pops up the possible filter settings.
In the middle of the Wizard window the symbols are shown with full names and details. It is possible to zoom the window by clicking the icon at the right top-most corner.

The symbols can be selected one by one by checking the checkbox beside the symbol. Or at the top beside the Point Name by checking the checkbox all the symbols are getting selected in the actual group.

The Data Format can be changed per Points. For example, when Register is the data type from the PG5 project the format of the data in the register can be Signed / Unsigned Integer or Motorola / IEEE float.

6. The right side of the Wizard window shows those symbols which are selected therefore are getting imported. This window can also be zoomed. Beside the symbol the big X icon is used to remove the symbol from the selection.
7. Because in the middle window of the wizard shows all the symbols the System integrator has to be able to select the symbols which are needed to be imported. Filter can be defined, so only the interesting symbols will be shown. It is possible to select the type of the symbols to be filtered. Or it is possible to define symbol groups not to be displayed. For that user must click to the + icon at the right side of the list and define the Group name (e.g. Web). There are some default symbol groups predefined. Click to Apply to make the filter settings effective.

8. We need the symbols from the Heating1 group and also from the Web group. Select them and press the Next.
9. Pop-up window is displayed to warn you to overwrite or not the datapoint (the first one in the list).
   It is possible to select the action for the remaining conflicts of the point database.
   Check the “Do this for all conflicts” and press Overwrite.

**Presently it works this way**
- Overwrite = it overwrites the addresses and also the comments
- Skip = it overwrites the addresses only

![Image of pop-up window]

*During new import the Saia PG5 Data Import Wizard will retain all user defined configuration of a datapoint, except memory address and comment.*
10. The SBCIpNetwork driver folder is automatically generated under the Drivers folder of the Station. The datapoints were imported to the Points folder of the SBCIpNetwork driver. The datapoints are hierarchically structured as they are in the PG5 symbol table. The main folder of the Points are named according to the Device name in the PG5 project.

*PCD device name can be the same in different PG5 Projects. Take care of it and make it sure that the imported Device names are unique in the Saia PCD® Supervisor.*

*The Import Wizard always put the points in the SBCIpNetwork folder. This folder can be renamed. The next import then will be done to the renamed folder. The target folder of the import can not be freely chosen.*
11. It can happen that the generated structure is not fitting to the predefined structure of the Saia PCD® Supervisor. Then it is possible to move the points to an other “SBCIpNetwork” with simple cut and paste action.

The not used “SBCIpNetwork” then can be deleted.

It is also possible to rename the element of the folder structure. It makes mainly sense to rename the PCD Device (the top folder). The folders under are having the right names since the PG5 project is also built up with structured symbol names. Let us rename it to “Device1”

Presently the Saia PG5 Data Import Wizard is not capable to follow up the Folder structure changes. So at the next import it will again import the symbols under the SBCIpNetwork under Drivers.
12. During the import a **Conversion with factor 0.1** is applied automatically to every Registers which has data type **Signed** or **Unsigned Integer**. This conversion is used because the numbers in the Registers of the PCD device are usually multiplied with 10. This multiplication is a kind of standard convention in case of Building Automation Projects. Of course the conversion can be removed or modified by hand. For example, we need to modify the conversion when we are working with time values. Then the division between minutes and seconds would be 60.

> During new import the Saia PG5 Data Import Wizard will retain all user defined configuration of a datapoint, except memory address and comment. User can choose to overwrite comment or skip during the process.
6.3.2.1 Properties of an imported datapoint

It can be seen in the AX Property Sheet of the datapoint that, there are many properties available.

We already touched the “Conversion”.

In this chapter the others will shortly be described.

Let us double click to symbol which is “Numeric Variable” type.

For example: Device1/Points/Heating1/.Outside/Temperature/PhysVal.

The AX property Sheet will come up because this is the associated page (default by the system, but changeable) to the datapoints.
Short description of the properties (top to down, row by row):

1. **Name of the data-point**
   - without group structure and the type in bracket. The type of the datapoint is determined by the Saia PG5 Data Import Wizard during import. (changeable)

2. **Facets**
   - This property allows you to configure how the value of the component is displayed. For example, on a Numeric Writable component you can set the units, precision, minimum and maximum value for the Out property value.

   In case of the example we can use the following settings. We use three decimal precision. The “-inf and +inf” are the +/- infinity. As it is a measurement which comes from the PCD controller we do not need to set min and max. But for a writable parameter for a setpoint or for an output it makes sense to define the min / max parameter in order to ensure the operator typed value never goes out of its borders (e.g. by mistyping). The engineering unit can also be selected.

   ![Facets settings](image)

   **info**

   Unfortunately the Facets settings are not set automatically for the imported points. This means that the Facets parameters must be set for every each imported points manually.
3. **ProxyExt** We use in the Saia PCD® Supervisor so called Proxy Points (this is a feature of the Niagara framework). The function of the Proxy Point is to show the values of the symbols from different controllers in a uniformed way. The Proxy Points then are behaving in the same way inside of the Saia PCD® Supervisor regardless if they come from a SBC PCD controller or from a third party device.

1. **Status**
   - {ok} communicating and ok
   - {fault} communicating but the value is not correct
   - {down} no communication
   - {disabled} point is disabled
   - {stale} the value of the point is not trustworthy

2. **Fault cause** Possible cause of the fault

3. **Enabled** Enable / Disable the communication of this datapoint (Save it if modified)

4. **Device Facets** In cases for drivers that support a “Discovery” mechanism, a proxy point may be created with its facets (units) already defined—these reflect its “Device Facets” (in its ProxyExt). Not applicable for Saia PCD Devices due to no discovery.

5. **Conversion** (Type, Scale and Offset): the raw value comes from the PCD controller can be converted using different mathematical transformation.

6. **Tuning Policy** If other tuning policy has been defined it can be selected here. The Tuning Policy is used to define how frequently the datapoint is communicated.

7. **Read Value** Value from the controller as it is.

8. **Write Value** The type of the datapoint is Numeric Writable. So it possible to write back value to the PCD Controller. Because the connected variable in the PCD controller is a freely readable and writable Register. Other hand it can happen the user program in the PCD controller s just cyclically overwriting this Register.

9. **Memory Address** The address of the memory slot in the PCD controller to communicate with.

10. **Data Format** How the value is represented in the memory slot in the PCD controller.
Using the “Saia PG5 Data Import Wizard”

4. **Out**
   This is the value which can be visible in the Saia PCD® Supervisor and be used/connected to other place (e.g. creating logic in the Wire Sheet).

5. **In1 to In16**
   These are inputs of this Proxy Point, if we see it as a Function box. The inputs can be connected to somewhere to get values or it is possible to define the value directly. There is a defined priority between the inputs (lowest In16). The values of the inputs can be enabled / disabled with checking the checkbox “null”. Then the values which is the highest priority will be downloaded to the PCD controller.

6. **Fallback**
   When any of the Input are not applied the Fallback value is applied.

7. **Override Expiration**
   It is possible to command Permanent or Time-duration bound override. When Time bound override is applied, then the Override Expiration shows the time and date when the override goes back to Auto automatically.

8. **Media Type**
   The type of the memory slot in the PCD controller. Needed for the correct communication.

9. **Comments**
   Imported comment from the PG5 project.

10. **Icon**
    Internal picture associated to this type of variable.

Certainly the other type of datapoints have a bit different looking Property Sheets. I do not describe every each of them. To get familiar with them needs self-study and reading the manuals.
## 6.3.3 Alarming

### Importing Alarm list generated in the PG5 project

There are at least two possible ways to handle the Alarms in the Saia PCD® Supervisor.

1. The Alarms are generated in the PCD controller. They are organized to a memory territory, with Alarm text, time stamp, status (Acknowledged, Deleted, New, etc.) and comment. This information can be then imported to Saia PCD® Supervisor.

   *Only SBC Web-Editor 8 generated Alarm lists are supported. SBC DDC Suite based alarms are not supported. Before importing the Alarm list and the HD Logs the web project in the Web-Editor 8 must be compiled. Take care to select the language for the Alarm list before compile in the Web-Editor 8. The up to date configuration files (csv files) must be available for import.*

2. In the Saia PCD® Supervisor there is alarm service which can be used to set Alarms for individual datapoints, regardless if the datapoint is considered alarm or not at the start of the engineering. For example the Outside air temperature can generate an alarm when it is crossing the -20°C. For that we need to set monitoring of this temperature in the Saia PCD® Supervisor. So the Alarm is generated in the Saia PCD® Supervisor not in the PCD controller. Therefore this alarm can not be seen for example in the SWeb application.

Here in this chapter we will see how to import the Alarm list form the PCD controller.

1. The Saia PG5 Data Import Wizard must be started.
2. The right PG5 project file must be selected in the File edit field.
3. Check the Alarm List checkbox

![Saia PG5 Data Import Wizard](image-url)
Creating/Engineering a project

Using the “Saia PG5 Data Import Wizard”

4. Press Scan. The Alarm list of the selected PG5 project is being scanned.

5. Select the Alarm list to be imported.

6. If the Alarm list is generated with more languages then select the required language.

7. Press Next. And confirm to overwrite the Alarmlist.
8. The Import is running

![Image showing the import progress](image)

Import is ready. The details can be checked under the Device/Alarms folder.

More details are not available.

9. Check the Alarming behaviour by generating test alarms in the corresponding SBC PCD controller.
6.3.4 Importing Historically logged data so called HD Logs

There are at least two possible ways to handle the Historically logged data in the Saia PCD® Supervisor.

1. The HD Logs are generated in the PCD controller. The HD Log data can be saved in different format and into different memory territory in the PCD device. The Saia PCD® Supervisor supports only "csv" file based log data which are saved to the Flash File System of the PCD device. (This means that, the HDLog 3.0 Fbox generated logs, which are saved to INTFLASH, M1_2FLASH and SLOT0_3FLASH can be imported.)

2. In the Saia PCD® Supervisor there is History Service which can be used to log the interesting values to the hard drive of the PC. So the logged data then any time can be retrieved and can be displayed e.g. as a trend curve. So the Historical Log is generated in the Saia PCD® Supervisor not in the PCD controller.

Here in this chapter we will see how to import the HD Logs from the PCD controller.

1. The Saia PG5 Data Import Wizard must be started.
2. The right PG5 project file must be selected in the File edit field.
3. Check the HD Logs check box, and press Scan.

4. Press Proceed or select the right codepage manually and press Proceed.
5. Summary of the found HD Logs is displayed, press **Next**

6. The detail view of the HD Logs is displayed. Select the needed HD Log files. Inside of one HD log file can be many different data points logged (symbols). Then press **Next**.

7. Check the check box and press **Overwrite** to proceed. The existing configuration will be overwritten.

8. The Import Wizard reports the successful import.

Import is ready. The details can be checked under the Device/Alarms folder.
9. Check the result in the NAV tree / Device / Histories.

10. The default settings is to get the data from the PCD device (controller) once per day. This can be changed to get the data faster for example every 10 minutes.

![NAV tree / Device / Histories]

### 6.3.5 Starting the communication after the import

Drivers can be seen effectively as language packs. After the execution of the Saia PG5 Data Import Wizard we have got a new driver called the SBCIpNetwork. Once a driver is in place and configured the Saia PCD Supervisor can speak to that protocol.

The PG import wizard works offline. It does not require a network connection to the PCD.

If the IP address and S-Bus station number of the Saia PCD was correctly configured in the Device configurator and the PCD with the Saia PCD® Supervisor software is connected to the same network and if the network setup is correct, then the communication should work directly after the execution of the “Import wizard” without problems.
6.3.5.1 Enabling the Saia S-Bus IP-Driver

1. In the Nav tree open the Station/Drivers/SBCIpNetwork. Double click on the Device1.

2. In the property sheet check the settings (red colour marked lines) and enable the driver.

3. Save the modification.
6.3.5.2 Checking different settings to get the communication working

The following picture shows that the communication is not working the devices are orange colored.

The following steps are needed to do debugging communication problems.

1. Check the communication between PG5 and the Device
   This only works if the PG5 is installed onto the same PC

   It should be possible to go online to the PCD with the online configurator of PG5 over a "Socket connection"
2. If it’s not possible to go online over Socket to the PCD, try to ping the IP-address of the PCD.

If it’s not possible to PING the PCD, there must be a problem with the network setup (e.g. IP address or Subnet mask) or there is a problem with cabling or switches or there is problem with Windows Firewall Settings:
- File and Printer sharing must be enabled
- ICMP Echo Requests must be enabled
3. If there is connection to the controller but PCD Supervisor reports communication error, check the settings in the network driver.

4. Restart the Platform Demon at last. It is possible that restarting the Platform Daemon will help because the used network adapter and ports settings are getting updated after restart.
The communication is ok when the Devices are not colored and their status is {OK}. In addition, it is possible to see valid information of the PCD in the Nav tree Device Information subdirectory.

6.3.5.3 Tuning the Saia S-Bus IP-Driver

There are not so many possibilities given to fine tune the communication. It is possible to set three different kind of speeds (Fast Rate, Normal Rate, Slow Rate) as base. Then it is possible to set up the rates for a complete device.

The polling rate is the same for all datapoints within a Device.
General functions

For the Alarm list it is possible to set a polling rate. As default **30 seconds** is set. Which means, that the alarms located in the Saia PCD device are polled in 30 seconds. Then the new alarms and/or acknowledgment are transferred. The polling rate can be adjusted or scheduled. The details of the different settings can be found in the Niagara documentation.

![Alarms Poll Frequency](image)

For the Histories (HD Logs) it is also possible to set a polling rate. The default settings is **Daily at 2 o'clock in the morning** to retrieve the HD logs from the Saia PCD Device. This setting can be changed to e.g.: **Interval, 30 seconds**. Which means, that every 30 seconds the HD Log data is polled, then the new values are uploaded to the History files of the Saia PCD Supervisor. The details of the different settings can be found in the Niagara documentation.

![Histories](image)
6.4 General functions

6.4.1 Configure Scheduled tasks

This chapter describes how to configure Schedulers to control the automations system during occupied and non-occupied time.

Scheduler

The Scheduler provides control of values and changes setpoints based on time and date. Lights, Fans, and HVAC equipment are turned on and off based on the time, day of week and date. The Scheduler is also used in process control and manufacturing applications.

Presently there is no Saia PCD Supervisor compatible Schedulers in the SBC PCD Device. It means that, if the automation system needs high level scheduling functions, this must be done “upstairs” in the Saia PCD Supervisor not in “downstairs” in the PCD Device. Which has the drawback that if the Supervisory computer fails to work the Scheduling function fails too.

There is an exception. It is possible to use the Saia PCD Device as BACnet Controller, in this way the BACnet standard scheduling functions can be used. This is compatible with the Saia PCD Supervisor. However it needs to license and use the 3rd party (BACnet) driver in the Saia PCD Supervisor.

Schedules are created using schedule components found in the schedule palette. Place these components in a station, configure, and link as needed to provide scheduling control of other components.

Scheduling functionality is the same whether using Workbench or an HTML5 web browser with one exception. Currently, in a web browser connection, you do not have the options to copy or paste components.
### General functions

#### Schedule component categories

<table>
<thead>
<tr>
<th>Component category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Weekly</strong></td>
<td>Weekly schedules define regular, repeating, events by “time-of-day” and “day-of-week.” Also, you can configure any number of “special events” on a weekly schedule. Weekly schedules are the most used schedule components. Four different types vary by data category (Boolean, Numeric, Enum, and String). Each is identical except for input/output.</td>
</tr>
<tr>
<td><strong>Calendar</strong></td>
<td>Calendar schedules define specific days. Use a calendar schedule to define days with scheduling exceptions (e.g., holidays), and reference them in the “special events” setup of weekly schedules.</td>
</tr>
<tr>
<td><strong>Trigger</strong></td>
<td>Trigger schedules fire actions or topics. With a set of pre-configured schedules and a ScheduleSelector component, you can simply choose from a list of valid schedules to setup or change the schedule of a device.</td>
</tr>
<tr>
<td><strong>Selectors</strong></td>
<td>Schedule Selector components provide an easy way for you to select a schedule to use for controlling a particular component. As needed, you typically link its output to an action of a control point or extension.</td>
</tr>
</tbody>
</table>
### Schedule component views

<table>
<thead>
<tr>
<th>Component</th>
<th>Default view</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Weekly</strong></td>
<td>Default view for any weekly schedule component. In Workbench the Scheduler view provides four configuration tabs:</td>
</tr>
<tr>
<td><strong>Weekly Schedule</strong></td>
<td>Sunday-through-Saturday (weekly) event times/values. Use this to define the regular weekly events.</td>
</tr>
<tr>
<td><strong>Special Events</strong></td>
<td>All exceptions to the defined weekly schedule, as special events. Use this to define special event times.</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Important properties such as default output, schedule effective times, special event clean-up operation, and schedule facets.</td>
</tr>
<tr>
<td><strong>Summary</strong></td>
<td>for any selected day, provides a tabular summary of all schedule events, with source. Also available under the Scheduler view dropdown list:</td>
</tr>
<tr>
<td><strong>Current Day Summary</strong></td>
<td>provides a simple 24-hour linear graph of schedule event times and values for the current day.</td>
</tr>
<tr>
<td><strong>Calendar</strong></td>
<td>Default view for a CalendarSchedule component. The Calendar Scheduler view provides a calendar where you can add, edit, or delete specific calendar days (exceptions to the regular weekly schedule) and establish relative priorities.</td>
</tr>
<tr>
<td><strong>Trigger</strong></td>
<td>Default view for a TriggerSchedule component. The Trigger Scheduler view provides a two-part view combining a “day picker” and an event “time picker” for specifying when topics are fired on those days.</td>
</tr>
</tbody>
</table>

We configure a Weekly schedule and a Calendar Schedule in this chapter.

*In a web browser the Scheduler view provides two configuration tabs: Weekly Schedule and Special Events. While the Current Day Summary and Property Sheet views are available under Scheduler view dropdown list.*
Examples

- **Weekly Schedule**
  The task is to configure a weekly schedule which switches on the Light in the normal office time from Monday till Friday and from 8:00 till 17:00. Friday the office time is reduced only from 8:00 till 14:00.

  There is special event on 1st of September 2017. In this day the Light must be switched off from 9:00 till 11:35 due to test.

- **Calendar Schedule**
  There are known official Holidays like Christmas or the Swiss National Day where the office is unoccupied therefore the Light must be Switched off.

The steps to add and configure Schedulers to the Saia PCD Supervisor:

1. Creating folder for the scheduling components
2. Add Weekly Scheduler component from Palette
3. Configuring normal events weekly schedules
4. Configuring special events weekly schedules
5. Add Calendar Scheduler component from the Palette
6. Configuring Calendar Schedule
7. Make the logic to control the physical point in the PCD device
   or
8. Make the logic to control the physical point in the PCD device using reference between the schedulers.
6.4.2 Creating folder for the scheduling components

Schedules can be created and added to any part of Saia PCD supervisor. However, it makes sense to manage these in a central location.

1. In the Nav tree open 127.0.0.1(localhost) > Station > Config
2. Create there a folder called Scheduler.
3. Double click to the folder. The associated Wire Sheet will be opened.

More details of using Wire Sheet can be found inside of the Niagara documentation.
6.4.3 Add Weekly Scheduler component from Palette

1. Open the schedule palette

2. Drag and Drop the BooleanSchedule component to the Wire Sheet of the Schedulers folder.

3. In the pop-up dialog specify the name of the component (Weekly_Schedule_Light)

4. A Weekly Schedule component is placed to the Wire Sheet.
6.4.4 Configuring normal events weekly schedules

1. Double click to the Weekly_Schedule_Light function box to open the Scheduler configuration window.

   Saia PCD supervisor Schedules operate Sunday to Saturday and times are set from top to bottom.

2. In the weekly view specify the time range for Monday. For that go to Monday 8:00 press the mouse left button and drag the mouse down till 17:00 o´clock. The defined time range will be shown as green stripe.

3. Do not worry if you do not find the exact time. Below the graphical representation, in the Event Starts and Event Finishes edit fields it is possible to type it.

   In the headings of the green stripe and in the Event Output drop down box the scheduled value can be seen (true). It is possible to invert it.

4. Define time schedule for Tuesday to Friday too in the same way. Take care the office time in Friday is until 14:00.

   It is possible to do copy and paste. Right mouse click to the green stripe and select copy day. The selected time span is then shown in blue colour. Right mouse click to the remaining days and select paste day. Then set Friday 14:00 o´clock.
5. Click Save at the bottom of the page.

6.4.5 Configuring special events weekly schedules

1. Click to Special Events at the bottom of the page.

2. The Special Events summary page opens with the Today schedule visible.
3. Click to Add and specify the date 1st of September 2017.

4. Click OK

5. Specify the schedule to switch off the Light from 9:00 till 11:35. Do this at the right side of the window by using the mouse and typing the values by hand. Do not forget to specify the “false” value to switch off the light

6. Save the configuration
7. Check the summary. Click to Summary at the Bottom of the page. Navigate to 1st of September 2017. Then in the text summary it can be seen the Special Event entry.
6.4.6 Add Calendar Scheduler component from the Palette

1. Open the schedule palette
2. Drag and Drop the CalendarSchedule component to the Wire Sheet of the Schedulers folder.
3. In the pop-up dialog specify the name of the component (Calendar_Schedule_Light)
4. A Calendar Schedule function box is placed to the Wire Sheet.
6.4.7 Configuring Calendar Schedule

1. Double click to the Calendar_Schedule_Light function box to open the Scheduler configuration window.

2. Click Add to schedule the Christmas holiday from 25th of December till 31th of December.

3. Click OK and then click Save.

4. Then it makes sense to define a holiday for 1st of January.
5. Then specify the holiday for the 1st of August (Swiss National Day)

6. Click OK, Click Save, Click Refresh.

7. Check the settings. Green background of the dates means schedule is set.
6.4.8 Make the logic to control the physical point in the PCD device

The previous steps are describing how to add and configure the needed schedulers. It is needed to transfer the Schedulers combined Out value to the data point which is really communicated to the PCD Device. This point is called Enable_Light in the Saia PCD Supervisor. In the PCD Device the application program monitors this Flag and according to its state enables the light on/off.

Keep in mind. In the Calendar schedules we specified the Holidays, when there is nobody in the building. During the specified time the Calendar Schedule output will be high. We need to negate the output of the Calendar Schedule to get the correct logic.

1. Navigate in the Nav tree to the Scheduler folder.
2. Double click to the Scheduler folder. The Wire Sheet pops up.
3. Open the kitControl Palette.
4. Drag and drop the “And” and “Not” function block form the Logic folder to the Wire Sheet.
5. Connect the function block together as the picture shows.

The **Out** pin of the And Function box must be connected to the Enable_Light pin **IN16**. But these Function Boxes are located in two different Wire Sheets. We need to link these two pins together.

6. Open the Wire Sheet for the Scheduler folder (if it is not open). And select the And-Function Box.
7. Right mouse click to the **Out** pin of the And Function box, then select the Link Mark command from the context menu.

8. Navigate to the Points folder of the Device where the Enable_Light point is located.

9. Right mouse click to the **Points** folder and select the Wire Sheet form the views menu.

10. Organize the Function Boxes on the sheet to get some spaces between them.

   At first time you open this Wire Sheet the Function Boxes which are representing the Points in that folder are overlapping each other. The Function Boxes are configured that way that the **Out**, **In10**, **In16** pins are visible. Right now these pins are enough for our work. But keep in mind that, the visibility of the pins are configurable, so many other pins can be set to be displayed.

   The meaning of the pins can be checked deeply in the Niagara manual.

11. Right mouse click to the **In16** pin of the Enable_Light Function Box.
12. Select the **Link from “And”** command form the context menu.

![Image showing Link from “And” command](image1.png)

13. In the pop-up window the link between the two Function Boxes must be defined as the picture shows. The link can be checked by reading the text at the bottom left corner of the window.

![Image showing Link in the pop-up window](image2.png)

14. Click OK. The pop-up will be closed.

15. In the Wire Sheet check the marks of the link and also check that the link is live. It means that the Points/Enable_Light function box **In16** pin follows the Schedulers/
And Function Box Out pin of the And function box.

16. The state Out pin of the Enable_Light function box normally follows the state In16 pin. The Out pin shows directly which value is downloaded the PCD device.

17. If the state of the Out pin has different value then the In16 pin the following can happen.

A. The Out pin is forced by operator -> set back to Auto

B. - Other higher level of InX pin is getting value from somewhere.  
   - Check the logic if it is valid
C. - Inside of the Function Box other InX pin is selected with value to override the output.
- To check it double click to the Function Box.
The prioritized override technique of the Out pin is described in the Niagara manual.
- The picture shows that, In2 overrides In10 and In16 to command the Out pin.
6.4.9 Make the logic to control the physical point in the PCD device using reference between the schedulers.

The previous steps are describing how to add and configure the needed schedulers. It is needed to transfer the Schedulers combined Out value to the data point which is really communicated to the PCD Device. This point is called Enable_Light in the Saia PCD Supervisor. In the PCD Device the application program monitors this Flag and according to its state enables the light on/off.

Keep in mind. In the Calendar schedules we specified the Holidays, when there is nobody in the building. During the specified time the Calendar Schedule output will be high. We need to negate the output of the Calendar Schedule to get the correct logic.

There is another more elegant way to make the connection between the Calendar Scheduler and the Weekly Scheduler. The way is to define reference between them.

The Calendar Scheduler is higher in priority, so we need to make a reference from the Weekly Scheduler to the Calendar Scheduler.

1. Navigate in the Nav tree to the Scheduler folder.
2. Double click to the Scheduler folder. The Wire Sheet pops up.
3. Double click to the Weekly_Schedule_Light. This will open the configuration window of the Scheduler.
4. Click to Special Events at the bottom of the page
5. Click to Add
6. In the pop-up window go to the Type and select Reference then click to OK.

7. In the next pop-up window it is possible to select to which Scheduler the reference must be added. Here there is only one scheduler listed. Select Calendar_Schedule_Light then click OK.
8. The Event = Reference to the weekly scheduler is added. But it is "Unscheduled", can be seen in the right side.

9. We need to define that during the Holidays, when the Calendar\_Schedule\_Light is high the Weekly\_Schedule\_Light must be low. For that the complete time range has to be defined to false.
10. Save the settings

11. Test the configuration by adding the today to the Calendar_Schedule_Light. This means create today as Holiday day.

12. Check that the Weekly_Schedule_Light Out pin goes low.

13. Remove the test setting from the Calendar_Schedule_Light.

14. Create reference between the Weekly_Schedule_Light Out pin and the Enable_Light In16 pin in the same way as it was described above. As you see the Not and the And Function Boxes are not needed to realize the same function.
6.5 Connect to 3rd Party Systems

If you have purchased an OPEN license and want to use values from non-Saia Burgess Controls systems it is necessary to connect to the 3rd-party systems and add the required points to the Saia PCD® Supervisor database.

6.5.1 Add the Required 3rd Party Drivers

1. In the Nav tree open the Station folder.
2. Open the Config folder.
3. Double click on Drivers. The view pane will show a list of installed Drivers (Driver Manager).
4. Click on the New button. The New dialogue box is displayed.

In the Type to Add box select the required driver, e.g. ‘BacnetNetwork’.

5. Click OK. The following dialogue box is displayed.

6. Click OK. The Driver Manager will now show the driver.

7. You now need to configure the driver
6.5.2 **Configure 3rd Party Drivers**

The configuration of each 3rd party driver is different, refer to the Tridium Niagara documentation for the details of the driver.

6.5.3 **Add 3rd Party Points to the Database**

The method of adding points to the database for each 3rd party driver is different, refer to the Tridium Niagara documentation for the details of the driver.

6.5.4 **Using the BACnet Driver**

The ability to use values from a BACnet system is quite common and is supported by Saia PCD® Supervisor. This section provides an overview of how to use the BACnet driver with Saia PCD® Supervisor. For full details refer to the Tridium Niagara documentation.

6.5.4.1 **Configure the BACnet Driver**

1. In the Nav tree open the Station folder.

2. Open the Config folder.

3. Double click on Drivers. The view pane will show a list of installed Drivers (Driver Manager).

4. In the Nav tree open the folder for the already added BACnet driver (BacnetNetwork) and double click Local Device.

5. Set the Object Id to the Saia PCD® Supervisor address on the BACnet network (range 1-4194302).
6. In the Nav tree open the BACnet Comm folder and double click Network and expand the IP port section also the adapter has to be chosen.

7. Set the Network Number to 1.

8. Set Enabled to true.

9. Click .
6.5.4.2 Discover and add BACnet Devices

In the Nav tree, open the Drivers folder and double click the BACnet driver. The view pane will display the Bacnet Device Manager.

1. Click to Discover

The Configure Device Discovery dialogue box is displayed.

If the address range of controllers is known then the Device Low Limit and Device High Limit can be edited to reduce discovery time.

2. Click OK.

The discovery process starts. A progress bar at the top of the pane indicates the status of the discovery. Once the discovery is complete the devices that have been discovered are displayed in the Discovered list.

<table>
<thead>
<tr>
<th>Status</th>
<th>Timestamp</th>
<th>Message</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Running</td>
<td>13-Apr-17 11:00 AM CEST</td>
<td>Finding BACnet Devices...</td>
<td></td>
</tr>
<tr>
<td>Message</td>
<td>13-Apr-17 11:00 AM CEST</td>
<td>Who-Are Local Broadcast All Devices</td>
<td></td>
</tr>
<tr>
<td>Message</td>
<td>13-Apr-17 11:00 AM CEST</td>
<td>Found BACnet device [objectid devices1] at address 1:172.30.13.4:7800...</td>
<td></td>
</tr>
<tr>
<td>Message</td>
<td>13-Apr-17 11:00 AM CEST</td>
<td>Reading parameters for device 1, 1 of 1</td>
<td></td>
</tr>
</tbody>
</table>
During the discovery process you can click on the button at the top right corner to display a Job Log giving details about the discovery process so far.

In the Discovered list select the device(s) from which values are required. To select more than one device hold down the CTRL key and click on the required devices.

Click Add or drag the selected device(s) to the Database list. The Add dialogue box is displayed.
Review the settings for each device:

- If required, change the device name in the Name box.
- If multiple devices are listed, click on the device in the list (to highlight it) to view its settings.

Check that the required devices have been added.

### 6.5.4.3 Add the required BACnet Points to the Database

This process allows you to add points, alarm configuration, schedules and histories from previously discovered devices.

1. In the Nav tree, open the Drivers folder and double click the BACnet driver. The view pane will display the Bacnet Device Manager.
2. In the Exts column of the Database list double click the required icon.

- Points
- Alarm Configuration
- Schedules
- Histories

The BACnet Point Manager is displayed.

3. Click Discover
4. The discovery process starts. A progress bar at the top to the pane indicates the status of the discovery.

Once the discovery is complete, points are displayed in the **Discovered** list:

![Image of the Discovered list]

5. In the **Discovered** list select the required points (values). To select more than one point hold down the CTRL key and click on the required points.

   *Remember that Saia PCD® Supervisor is licensed for use up to a specific number of points. It is good practice, therefore, to only add points that are actually required. Adding points that won't be used by Saia PCD® Supervisor will not only waste resources but also generate unnecessary extra network traffic.*

6. Click to **Add** or drag the selected point(s) to the **Database** pane.

7.
8. The **Add** dialogue box is displayed.

   ![]

   Saia PCD® Supervisor automatically chooses the most suitable writable point type. However, this can be manually changed by selecting a point in the list and choosing a different Item Type.

9. Click to **OK**

10. The selected point(s) is added to the database.

11. Repeat the above process to add points for each controller.
Creating Schematics (Operator Views)

6.6 Creating Schematics (Operator Views)

Schematics within Saia PCD® Supervisor are known as Operator Views (Presentation XML -- Px).

This section describes how to create the most commonly required features of Operator Views. For more in depth information please refer to the Tridium documentation.

It is recommended that you create a template page that contains features that are needed on each page, e.g. a logo, outside temperature, navigation buttons, etc. It is also recommended that you create a folder to store all the Operator Views, and another folder to store any images used on the pages.

The following steps are required to create Operator Views:

6.6.1 Prepare the folder structures

Preparing a good folder structure for the used Images and Operator views will help keeping the project clear and understandable. The engineering work will be faster because used elements can be easily found.

6.6.1.1 Create a Folder for the Operator Views

Operator Views can be created at any point within Saia PCD® Supervisor e.g. added to a folder, device or a module. However, this can make engineering unnecessarily complicated so it is recommend that a folder is created to contain them.

1. In the Nav tree open localhost > Station.
2. Right click Config and select New> Folder. The Name dialogue box is displayed.

Specify the folder's name e.g. 'Schematics'.
3. Click to OK.
6.6.1.2 Create a Folder for the Images

1. In the Nav tree open 127.0.0.1(localhost)>Station(Demo_Station).
2. Right click Files and select New> Folder. The Name dialogue box is displayed.

![Folder creation dialog](image)

3. Specify the folders’s name e.g. ‘Images’.
4. Click to OK.

6.6.1.3 Prepare Images

Any external images that are to be used on Operator Views must be created using a 3rd party graphics package and sized to the size required on the Operator Views.

*Once the images have been added to Saia PCD® Supervisor they cannot be changed. SVG (Scaled Vector Graphics) images can be used and scaled inside in the Saia PCD® Supervisor.*

6.6.1.4 Add Images to Saia PCD® Supervisor

To use images within Saia PCD® Supervisor they must exist within the file structure of Saia PCD® Supervisor.

1. In the Nav tree open My Host > My File System and navigate to the file that is to be added (this could be a folder containing multiple graphics).
2. Right click the file or folder and select Copy.
3. In the Nav tree open My Host > Station(Saia PCD Supervisor) > Files and navigate to the location the image(s) are to be stored.
4. Right click the location (e.g. images) and select Paste.
Creating/Engineering a project

Creating Schematics (Operator Views)

6.6.1.5 **Customize the basic PX Template Page**

Operator Views are created using the template PX Page (located - My Host > Sys Home > defaults > workbench > newfiles > PxFile.px). By editing this page all future Operator Views created will have this format.

1. In the **Nav** tree open **My Host > My File System > Sys Home > defaults > workbench > newfiles**.

2. Double click the **PxFile.px** file.

3. On the menu bar click the **icon to switch to PX Editor** view.

4. Design the page layout as required.

5. Save the file (select **File > Save**, or press CTRL+S).
6.6.2 Create a PX Page

Operator Views are created by making a new view of an element in the Nav tree and once a PX view is added it is the new default view of the element.

Operator Views are stored in the Saia PCD® Supervisor file structure, but are linked to the element where the view has been attached.

To keep structure simple it is a good idea to create subfolders. These subfolders hold the various schematics you want to create.

1. In the Nav tree open 127.0.0.1(localhost) > Station > Config and navigate to where the PX Page is to be located.

2. Right click the folder and select New > Folder. The Name dialogue box is displayed.

3. Specify the page’s name e.g. ‘HeatingCircuit1’.

4. Click OK A folder is created.

5. Right click the folder you have just created and select Views > New View. The New Px View dialogue box is displayed.
6. Enter the name of the page (same as the folder just created) in the View Name box.

7. Click OK The PX Page will be created based on the template page.

6.6.3 Edit a PX Page

The PX Editor is used to edit a PX Page.

1. In the Nav tree locate the PX file and double click on it.
2. On the menu bar click the icon to switch to PX Editor view.
3. Change the page layout as required
4. Save the file (select File> Save, or press CTRL+S).

6.6.3.1 Create or Change PX Page Elements

After creating a new PX Page or opening an existing page for editing use the following procedures to design the page layout and content.

6.6.3.2 Setting the Page Size and Background

To set the viewable area size:

1. Double click the layout grid to open the Properties dialogue box.
2. Click viewSize to set the visible screen size in pixels (maximum 10000 × 10000).
3. Click OK.

To set the background colour:

1. Double click the layout grid to open the Properties dialogue box.
2. Click the background as required and select either Solid or Gradient and use the colour picker to set the required colour(s).
3. Click OK.

To set the background image:

1. Double click the layout grid to open the Properties dialogue box.
2. Click the background as required and select Image.
3. Select the required image file and alignment settings.
4. Click OK.
6.6.3.3 Add Text

1. Right click the page and select **New > Label**. A label is added to the page.

2. Double click the label. The **Properties** dialogue box is displayed.

3. Enter the required text in the **text** box.

4. Click **OK**.

6.6.3.4 Add an Image

**Add your own image**

Images are sized on the screen based on their native dimensions (pixel size) - you cannot scale the image. Therefore, you may need to resize the image using your preferred graphics editor before adding to the page.

1. Navigate to the required image using the **Nav** tree.

2. Click and drag the file to the layout grid and position as required.

   - **It is recommended that any images you intend using in Saia PCD® Supervisor are first copied into a folder within the Station.**

   - **As you drag the item on the page two green lines indicate the top left corner where the item will be positioned.**
Create Schematics (Operator Views)

Add an Saia PCD® Supervisor Image

Saia PCD® Supervisor has some built-in images that can be added to a PX Page. Open the palette containing the required graphics. The following palettes contain useful images, but there are others available:

- **kitPx**: Covers elements like logoff, buttons, PxInclude, line, rectangle, etc.
- **kitPxHvac**: A library of various hardware graphics—pumps, boilers, etc.
- **kitPxN4svg**: Similar to kitPx but all graphics are SVG (scalable vector graphics).

1. Navigate to the required image using the palette.
2. Click and drag the image to the layout grid and position as required.

6.6.3.5 Add a Dynamic Object (Value)

1. Navigate to the required value using the **Nav** tree.
2. Click and drag the value to the layout grid and position as required.
3. When you release the mouse button, the **Make Widget** dialogue box is displayed.
4. Select **Bound Label**.
5. Select **Format Text** and choose `%out.value%` to display the value.
6. Select **Make Display Name Label** to display the label.
7. Click **OK**.
6.6.3.6 Add an Animated Image

Saia PCD® Supervisor has some built-in images that can be animated depending on value from the system.

1. Navigate to the value that is to be linked to the image using the Nav tree.
2. Click and drag the value to the layout grid and position as required.
3. When you release the mouse button the Make Widget dialogue box is displayed.
4. Select From Palette.

5. Open the palette containing the required graphics
6. Navigate to the required image using the palette.
7. Select the required image.
8. Click OK.
6.6.3.7 **Add a Setpoint Slider**

A slider can be added to enable an analogue value to be adjusted.

1. Navigate to the value that is to be linked to the slider using the Nav tree.
2. Click and drag the value to the layout grid and position as required.
3. When you release the mouse button the Make Widget dialogue box is displayed.
4. Select **From Palette**.

5. Open the KitPx palette
6. Select **SetPointSlider**.
7. Click **OK**.
6.6.3.8 Add a Button to Adjust a Value

1. Navigate to the value that is to be adjusted using the Nav tree.
2. Click and drag the value to the layout grid and position as required.
3. When you release the mouse button the Make Widget dialogue box is displayed.
4. Select Actions.

5. Select Set.
6. Click OK.
6.6.3.9 **Add a Link to Another Page**

1. Navigate to the PX Page that is to be linked to using the **Nav** tree.
2. Click and drag the PX Page to the layout grid and position as required.
3. When you release the mouse button the **Make Widget** dialogue box is displayed.
4. Select **From Palette**.

5. Open the KitPx palette.
6. Select **HyperlinkButton**.
7. Select the **Hyperlink** check box.
8. Enter the required text in the **text** box.
9. Click **OK**.
6.6.3.10 **Add a Graph**

1. Navigate to the required history using the **Nav** tree.
2. Click and drag the history to the layout grid and position as required.
3. When you release the mouse button the **Make Widget** dialogue box is displayed.
4. Select **From Palette**.
5. Open the webChart palette
6. Select **Chart**.
7. Click **OK**.
6.6.4 **Reuse Operator Views**

Operator Views can be reused, saving significant engineering time.

Normally Operator Views are created by using a new view attached to a folder in a centralised structure. However, as each PX Page is created in the file system in the ‘px’ folder, it is possible for a page to be reused by copying the file in the px folder and attaching it to the required folder.

1. Create a PX Page as required - see chapter 6.6.2 Create a PX Page
2. In the Nav tree open 127.0.0.1 (localhost) > Station(Demo_Station) > Files > px.
3. Right click the PX Page that is to be reused and select Copy.
4. Right click px and select Paste. The Name dialogue box is displayed.

5. Enter a name for the pasted PX Page.
6. Click to OK. The PX Page will be added.
7. In the Nav tree open 127.0.0.1 (localhost) > Station(Demo_Station) > Config and navigate to where the new PX Page is to be located.
8. Right click the folder and select **New > Folder**. The Name dialogue box is displayed.

9. Specify the folder's name e.g. 'HC2'.

10. Click **OK**  A folder is created.

11. Right click the folder you have just created and select **Views > New View**. The **New Px View** dialogue box is displayed.
12. Enter the name of the page created above in the **View Name** box.

13. Click **OK**  The **File already exists** dialogue box is displayed.

14. Click **Reuse**.

15. Edit the page as required.
6.6.5  **Reuse a Generic PX Page**

SBC PCD controllers often have the same control program and the associated Operator Views are identical, but reference data from different controllers. Or it is also possible that one controller has the same control program multiple times for multiple equipment.

To reduce engineering time a PX Page with generic references to data in the controller can be re-used for multiple controllers by attaching it to the required controllers (points) in the Nav tree. In order to do this every reference from the PX page to the controller (points) must be made generic, and the PX Page must be associated with the controller or points folder.

**Create generic PX page and make the ORDs relative:**

1. Create a PX Page as required - see chapter 6.6.2 *Create a PX Page*.
2. Open the **Bound Ords** pane.
3. Double click on the first ord that references a value in the controller. The **Edit ord** dialogue box is displayed.

![Original ORD in the Editfield:](image)

4. Edit the **ORD** to make it generic by removing references to the site, LAN, and controller. For example

![Edit ord](image)

5. Click **OK**.
6. Press CTRL+S to save the page.
Using Text Editor to make the ORDs relative

Text Editor can be used if more ORD has to be modified or the Relativize command can be used.

1. Right mouse click to the page in the px folder to relativize
2. Select Views -> Text Editor
3. The content of the px file is shown in XML format.
4. Go to Menu bar Text editor and chose Replace.
5. fill up the Find edit filed and the Replace with edit field.

6. Then click to Replace or All to replace one or all entries.

Associate a PX Page with a controller:

1. Right click the PX Page that is to be reused and select Copy.
2. Right click the px folder in the Nav tree and select Paste. The Name dialogue box is displayed.
3. Enter a name for the PX Page (e.g. HC_generic).
4. Click OK.
5. In the Nav tree navigate to the controller that the page is to be associated.
6. Right click the controller and select Views > New View. The New Px View dialogue box is displayed.
7. Enter the name of the page created above in the **View Name** box.

8. Click **OK**  The **File already exists** dialogue box is displayed.

9. Click **Reuse**.

### 6.6.6 Dashboards

A Dashboard is an element on a PX Page which each user can customise to their requirements.

To use dashboards the Dashboard palette needs to be opened and the Dashboard Service needs to be added to the Services section of Saia PCD® Supervisor.

Dashboard panes are added to the PX view like any other Graphic, but it requires some extra configuration.
6.6.6.1 Add the Dashboard Service

1. In the Nav tree open 127.0.0.1(localhost)>Staation(Demo_Station) > Config > Services.

2. Open the Dashboard palette and drag DashboardService onto Services. The Name dialogue box is displayed.

3. Click OK.
6.6.6.2 Add a Dashboard to a PX Page

1. Create the PX Page as required.
2. Open the Dashboard palette and drag DashboardPane onto the page.
3. Open the webChart palette.
4. Drag either Chart or Circular Gauge onto the content of the Dashboard pane in the widget tree.
5. Go online.
6. Drag & Drop an analog value to the gouge
6.7 Set Up Saia PCD® Supervisor Users

Security of Saia PCD® Supervisor is controlled by users. The access rights of each user determines what information the user can access and what things they are able to change/configure.

To achieve this the security within Saia PCD® Supervisor is managed using three services:

1. **Categories**
   Categories define what areas of the system a user can access.

2. **Roles**
   Roles are used to group the categories together that are required for a particular job and to define the level of access to those categories.

   E.g. a boiler engineer would only need access to the boilers but would require a high level of access. Therefore a role would be required for the engineers that gave high level access to the category that gave access to the boilers.

   An energy manager would need information from all the plant but with a lower level of access. Therefore a role would be required for the energy manager that gave low level access to a number of categories covering all the plant.

   Categories are assigned to roles using the Category Browser which is just another way of looking at the Nav tree.

3. **Users**
   Users define which roles the user has, their password, expiry, web access view.

   The ‘admin’ user is a superuser level access which has access to the whole system. Because of this details of the admin user’s password should carefully controlled.

   To configure users the required steps should be followed:
6.7.1 Configure Categories

Before creating the necessary categories it is necessary to plan what is required, you should consider the users and the distinct areas, then work out ‘Where’ needs to be granted access and create a category for each of these.

To configure categories the required steps should be followed:

6.7.1.1 Add a Category

User and Admin categories are created by default and additional categories are added using the Category Manager.

*The Admin category does not relate to the Admin user used to engineer Saia PCD® Supervisor.*

1. In the **Nav** tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config > Services.
2. Double click **CategoryService**
   
   The **CategoryBrowser** is displayed in the view pane.
3. Click the view changer box and select **Category Manager**.
   
   The **Category Manager** is displayed in the view pane.
4. Click **New**  The **New** dialogue box is displayed.

![New dialogue box](image)

5. Click **OK**  The dialogue box changes.

![OK button](image)

6. Enter the name of the category in the **Name** box.

7. Click **OK**.

### 6.7.1.2 Set up the Categories

1. In the Nav tree open **127.0.0.1(localhost) > Station(Demo_Station) > Config > Services**.

2. Double click **CategoryService**  The **CategoryBrowser** is displayed in the **view** pane.

![CategoryBrowser](image)
3. Grant each category access to the required areas of the system by clicking the required rows in the column for each category. To grant access to elements lower in the hierarchy expand the appropriate row and click.

Categories are a parent child system so selecting the top level will grant access to every child element under that level.

The inherit feature enables the access of the User category to be copied to another category. If there is a tick on the Inherit column for a row when that row is selected for another category the access from the User category is copied to the other category and removed from the User category. To reinstate access to the User category click the row in the User column.

Due to this it is potentially easy to accidentally remove rights.

A dot in a cell indicates access to that specific area. If the dot is black the access will not be affected by the Inherit tick, if it is grey it will be affected.

It is recommended that the Admin category is given the same access in the Config row as the User category i.e. leave the Inherit rows in the Config row are they are. For the other rows (Alarm, Files, and History) the Inherit rows can be unticked to enable you to specify the access more easily.

By default the ‘Admin’ and ‘New’ categories will have no access.

It is recommended that the ‘Admin’ category has access to some of the more complex areas of Saia PCD® Supervisor but not the whole of Saia PCD® Supervisor.

4. Click [ ].
6.7.2 Configure Roles

Roles use the categories to define what areas of the system can be accessed. They can have multiple categories assigned. It is best to configure Roles with job roles in mind rather than specific areas like categories.

1. In the **Nav** tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config > Services.

2. Double click **RoleService**  The **Role Manager** is displayed in the *view* pane.

3. Click **New**  The **New** dialogue box is displayed.

4. Click **OK**  The dialogue box changes.
It is recommended that the SuperUser (access entire station, file system) check box is NOT selected.

5. Click >> next to Permissions. The Permissions dialogue box is displayed.

6. Specify the permissions for each category by clicking the appropriate column for each category.

When you assign permissions, higher-level permissions (green check marks) automatically include the lower level ones (grey check marks). For example, if you enable admin level write (W), the system automatically enables admin level read (R), as well as operator level read and write (RW).

The first column, Category, lists the groups to which you may grant permission. The Operator and Admin columns relate to the permissions level configured on each component. Below these headings are the cells to use for assigning one of three permissions to each category:

- **R** Read allows the user to view the object.
- **W** Write allows the user to change the object.
- **I** Invoke allows the user to initiate an action related to the object.

Depending on how the permission level is set on the role, six permissions are derived:

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To allow a user to view operator level information</td>
<td>Check the Operator config flag on the slot and select the Operator R column on the permission map.</td>
</tr>
<tr>
<td>To allow a user to modify operator level information (if it is not read only)</td>
<td>Check the Operator config flag on the slot and select the Operator W column on the permission map.</td>
</tr>
<tr>
<td>To allow the user to view and invoke operator-level operations (actions)</td>
<td>Check the Operator config flag on the slot and select the Operator I column on the permission map.</td>
</tr>
<tr>
<td>To allow the user to view admin level information</td>
<td>Leave the Operator config flag unchecked on the slot and select the Admin R column on the permission map.</td>
</tr>
<tr>
<td>To allow the user to modify admin level information (if it is not read only)</td>
<td>Leave the Operator config flag unchecked on the slot and select the Admin W column on the permission map.</td>
</tr>
<tr>
<td>To allow the user to view and invoke admin-level operations (actions)</td>
<td>Leave the Operator config flag unchecked on the slot and select the Admin I column on the permission map.</td>
</tr>
</tbody>
</table>
7. Click **OK**.

8. Click **OK** A confirmation dialogue box is displayed.

9. Click **Yes**.

### 6.7.3 Configure Users

To configure users the required steps should be followed:

see chapter **6.7.4 Add Users** **6.7.4**

### 6.7.3.1 Configure NAV Files

NAV files are used to define the PX Page that is displayed when a user logs in. Each user must have a NAV file assigned. It is recommend that a folder is created to store all the NAV files.

### 6.7.3.2 Create a Folder for the NAV Files

1. Right click **Files** and select **New > Folder**. The **Name** dialogue box is displayed.

2. Specify the folder's name e.g. 'NAV'.

3. Click **OK**.
6.7.3.3 Create NAV Files

1. In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config and navigate to where the NAV file is to be located.

2. Right click the folder and select New> NavFile.nav. The Name dialogue box is displayed.

3. Specify the file's name e.g. 'Home'.

4. Click OK The file is created.

5. Open the folder containing the NAV file.

6. Double click the NAV file. The Nav File Editor is displayed in the view pane.
7. Click **Show Components**.

8. In the **Result Tree** double click to the NAV file. The **Edit** dialogue box is displayed.

9. Click ☐ next to **DefaultView**. The **Select Ord** dialogue box is displayed.

10. Navigate to the PX Page that is to be referenced by the NAV page and select it.

11. Click **OK**.

12. Click **OK**.
6.7.4 Add Users

1. In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config > Services.

2. Right click UserService and select Views > AX User Manager. The Ax User Manager is displayed in the view pane.

3. Click New. The New dialogue box is displayed.

![New dialogue box]

Several users can be added at the same time. However, it is recommended to add users individually to prevent confusion when specifying passwords.

4. Click OK. The dialogue box changes.
5. Double click of the new user

6. Enter the user's username in the **Name** box.

7. Enter the users full name in the **Full Name** box.

8. If the user is to expire on a specific date select the **Expires On** option and specify the required date.

9. Select the roles for the user in the **Roles** box.

10. Enter the user's password in the **Password** box. *Passwords must be 10 digits alpha numeric with one or more capital letter.*

11. Re-enter the user’s password in the **Confirm** box.
12. To force the user to change the password when they next login set **Force Reset At Next Login** to *true*.

13. To force the user to change the password on a specific date, select the **Expires On** option and specify the required date.

14. If the password is to expire on a specific date select the **Expires On** option and specify the required date.

15. Specify the NAV file that is linked to the PX Page that is to be displayed when the user logs in in the **Nav** file box.

16. Specify what happens when a user logs in from a web browser in the **Default Web Profile** box.

17. In the **Type** box select the required option.

18. It is recommend that you select **HTML5 Hx Profile** as it will render the graphics in a HTML5 format avoiding Java issues.

19. In the **Hx Theme** box select “SBC”.

20. Select **Yes** or **No** to specify whether the user has access to the following features:
   - Hx workbench views
   - Nav tree side bar
   - search side bar
   - palette side bar
   - Nav file tree
   - Config tree
   - Files tree
   - Histories tree
   - Hierarchies tree

21. Click **OK**.
6.8 **Backup & Restore**

To ensure that the Saia PCD® Supervisor configuration can be restored in the event of hardware or software failure it is recommended that the Saia PCD® Supervisor station is backed up. To reduce the risk it is recommended that the backup is performed in two ways:

> It is also important to ensure that the passphrase entered during the Saia PCD® Supervisor installation, platform password (normally PC login credentials) and the password for the ‘admin’ user (specified when creating the Saia PCD® Supervisor station) are available for use during any restore procedure.
6.8.1 Backup the Configuration

Using the Station Copier

The Saia PCD® Supervisor configuration can be copied from the localhost back to the local computer. This is not a true back up but it is useful as it makes the configuration available offline and thus reusable in future Saia PCD® Supervisor installations.

1. In the **Nav** tree right-click on **Platform** and select **Views > Station Copier**. The **Station Copier** is displayed in the view pane.

2. In the right-hand column (Stations on "localhost") click the station to be copied (e.g. Saia PCD® Supervisor).

   The Localhost is the live version of Saia PCD® Supervisor. Copying from left to right will overwrite the live version with an older PC version. **To copy the live version to the PC it is RIGHT to LEFT**

3. Click **< Copy**. The **Station Transfer Wizard** is displayed.
4. Enter the name of the backup copy (e.g. Saia PCD® Supervisor Backup).

5. Click **Next**.

6. Select **Copy every file in the station directory and its subdirectories**.

7. Click **Next**.

8. If the station already exists in the destination you will be prompted to delete the entire station, or just overwrite duplicate files. Select the required option and click **Next**.
9. Click **Finish** to start copying the files. Once the copy is complete the following dialogue box is displayed.

10. Click **Close**.

11. In the **Nav** tree open **My File System** and navigate to 
    C:/Users/MyUserName/Niagara4.3/Saia Burgess Controls/stations

12. Right-click the required station folder and select **Copy**.

13. Navigate to the required storage location (e.g. a plug-in memory device).

14. Right-click and select **Paste**.
6.8.2 Using the Backup Service

Using the Backup Service the backup file has not only the content of the station but also the default settings of the Workbench where the station was created and backed up. The user can as well specify, if the alarm or histories database should be a part of the backup .dist file.

Doing a station backup, will prevent data-lose of the running station in case of hardware or system failure.

Station backups are stored as ' .dist' files in

C:/Users/MyUserName/Niagara4.3/Saia Burgess Controls/backups

1. In the Nav tree open Station > Config > Services.
2. Right click BackupServices and choose Views > Ax Property Sheet.
3. In the Exclude Directories box click file:^^history and click ×.
4. In the Exclude Directories box click file:^^alarm and click ×.
5. Click Save.
6. In the **Nav** tree double click **BackupService**. The **Backup Manager** is displayed in the view pane.

7. Click **Backup**. The **File Chooser** dialogue is displayed.

8. If required rename the backup in the **File name** box.

9. Click **Save**.

10. Ensure the backup file is stored securely.
6.8.3   **Restore the Configuration**

6.8.3.1   **Restore Using the Station Copier**

To restore a station copy follow the procedure described in chapter
6.8.1 **Backup the Configuration** but copy the station from left to right.

6.8.3.2   **Restore the Station Using the dist file**

1. Rename the backup.dist file to a zip by renaming the extension and unzip it.

2. Copy the unzipped station to the User home station folder.

3. Use the station copier to copy it to the daemon home and start.
7 Using Saia PCD® Supervisor

This section covers the general procedures for day-to-day use of Saia PCD® Supervisor.

Once configured Saia PCD® Supervisor needs to be running all the time to enable to collect logged data, control occupation times, process alarms and allow users to access information.

If AUTO-START was selected when the Saia PCD® Supervisor station was created, the Station will be running whenever the PC is started and running.

If this is not the case the Saia PCD® Supervisor station must be started manually see chapter “7.3 Manual start the Saia PCD® Supervisor Station”

Go to ..

7.1 Access Saia PCD® Supervisor
7.2 Use Saia PCD® Supervisor
7.3 Manual start the Saia PCD® Supervisor Station
7.1 Access Saia PCD® Supervisor

Saia PCD® Supervisor can be accessed from a PC using the Saia PCD® Supervisor application or from a web browser.

*When accessing Saia PCD® Supervisor from a web browser not all features are available.*

7.1.1 Launch the Saia PCD® Supervisor Application

1. Click **Start** and choose **All Programs**.

2. Navigate to the **Saia PCD Supervisor** folder

3. Click **Saia PCD Supervisor v1.0R**
4. The Saia PCD® Supervisor application window will open:

![Application Window]

![Supervisor Interface]
7.1.1.1 Log on
(of course the Platform must be running always).

1. In the Nav tree double click on Station. The Authentication dialogue box is displayed with a default user selected:

2. To select a different user click Change User, otherwise go to step 5.

3. Enter a new Username.
4. Click OK.
5. Type the appropriate password in the Password box.
6. Click OK The user associated navigation (and start page) will be invoked

7.1.1.2 Log off

1. When you have finished using Saia PCD® Supervisor it is important to log off from Saia PCD® Supervisor to ensure that the system cannot be accessed by unauthorised users. Logging off requires you to disconnect from both the Platform and
Station.

2. In the **Nav** tree right-click on **My Host** and select **Disconnect**. The **Disconnect** dialogue box is displayed.

3. Click **Yes** to disconnect.

### 7.1.2 Access Saia PCD® Supervisor from a Web Browser

1. Go to the IP address of the PC running Saia PCD® Supervisor. The Saia PCD® Supervisor log on page is displayed.

---

*Please contact your local IT-department to get certificate!*
2. Proceed to localhost

3. Enter your user name.

4. Click **Login**.

5. Enter your password.

6. Click **Login**.

*If the correct certificates are installed then the security warning is not coming up. The connection is immediately built from the browser to the server.*
### 7.1.2.1 Log off

1. Click "X"

2. Click Yes.
7.2 Use Saia PCD® Supervisor

Once you have accessed Saia PCD® Supervisor it can be used in two different ways:

→ 7.2.1 Using Saia PCD® Supervisor via Operator Views
→ 7.2.2 Nav Tree

The method you use will depend on how Saia PCD® Supervisor has been configured, your level of access and the tasks you want to do.

7.2.1 Using Saia PCD® Supervisor via Operator Views

Use of Saia PCD® Supervisor via Operator Views (PX Pages) requires more initial configuration, but enables users to access the system using graphical pages tailored to their requirements in a controlled way.

The Operator Views will have been designed to provide clickable links to either move between pages or select particular controls (e.g. to change a set point, change occupancy times, etc). When you log in you will be taken to a landing page from which you can navigate to the required information and, if allowed, make adjustments. Simply click on the links provided; the user interface should make it obvious what the link does.

7.2.1.1 Access the Operator Views

When you log on a PX Page will normally be displayed allowing you to navigate to parts of the system that you have access to.

If a PX Page is not displayed and you want to navigate the system using Operator Views you will need to display the required page from the Nav tree.

1. In the Nav tree open
   127.0.0.1(localhost) > Station(Demo_Station) > Files > PX > and navigate to the required PX Page (start page).

2. Double click the page.

7.2.1.2 Use the Operator Views

Navigation

Once a PX Page is displayed you will be able to navigate to other parts of the system by clicking on the links provided. These links may be in the form of text hyperlinks buttons, or graphics with hyperlinks depending on how the page has been configured. The display should make it clear the function of each item on the page.
The next and previous buttons ( 

) can be used to move between the pages you have already viewed.

**Adjustments**

If you have the authority and the page has been configured appropriately you may be able to make adjustments by clicking on various graphical elements, e.g. sliders and buttons.

The meaning and use of such items should be intuitive.

### 7.2.1.3 Use Dashboards

A Dashboard is an item on a PX Page that enables you to choose the information that is displayed. Once you have set up the item it can be saved so that next time you visit the page your selections are visible. Selections made by other users do not affect yours. A PX Page may contain one or more dashboard items.

There are two types of dashboard item; Gauges and Charts.

**Gauge**

A gauge type dashboard appears as shown below and enables an analogue value to be represented in a graphical way.
Chart
A chart type dashboard appears as shown below and enables values to be represented as a graph, e.g. histories. Time schedules can also be added enabling you to view the occupancy state and when a parameter is at a certain value.

7.2.1.4 Configuring a Dashboard

Configuring a dashboard requires access to the Nav tree.

Adding an item to a Dashboard
- Use the Nav tree to locate the point required.
- Drag the point onto the dashboard. For charts you can add more than one value.

Save a Dashboard
- Click on the dashboard.
7.2.2 Using Saia PCD® Supervisor via the Nav Tree

7.2.2.1 Basic Controls and Navigation
To see the location of the following Saia PCD® Supervisor controls and features, refer to the diagram on chapter "2.2 User Interface Application (Host PC)"

7.2.2.2 Nav Tree
To show the side bar:
- On the menu bar select **Window > Side Bars** and ensure **Show Side Bars** is checked.

To add a Nav tree to the side bar:
- On the menu bar select **Window > Side Bars > Nav**.
- Click the file icon and select the Palette type from the displayed options.

To remove a Nav tree from the side bar:
- Click the arrow to the left of the **Nav** tree title and select **Close**.

7.2.2.3 Palettes
To show the side bar:
- On the menu bar select **Window > Side Bars** and ensure **Show Side Bars** is checked.

To add a Palette to the side bar:
- On the menu bar select **Window > Side Bars > Palette**.
- Click the file icon and select the Palette type from the displayed options.

To remove a Palette from the side bar:
- Click the arrow to the left of the **Palette** title and select **Close**.

7.2.2.4 Locator Bar
To navigate down the hierarchy:
- Holding the mouse over an item: a small arrow will appear.
- Click the arrow to reveal a drop down box and select the required option.
- Click on an item in the bar to navigate back to that level.
To navigate to specific location:
- Click in a blank area of the locator bar and type the path directly into the box.

7.2.2.5 View Pane & View Changer
To change the view of a selected item:
- Click the view changer box and choose the required view.
  Or
  Right-click the item (e.g. in the Nav tree), then select Views > and the required view.

7.2.2.6 Viewing and Changing values of a Point

To view a point value:
- Use the Nav tree to locate the point required.
- Double click the point (or right-click and select Views > AX Property Sheet) to view its Property Sheet. The Out item will indicate the current point value.

To change a point value (writable points only):
1. Use the Nav tree to locate the point required, right-click the point and select Actions > Set Value.
   Or
   Click the button that allows the value to be adjusted.

   The Set dialogue box is displayed.

   ![Set dialogue box]

2. Type the required value.

   As default Saia PCD® Supervisor does not check that the value entered is valid. The limits can be set for Numeric Writable. When the operator types value outside of the limits the value will not be accepted.

3. Click OK.
7.2.2.7 Viewing Alarms

Viewing Alarms Using the Alarm History

1. In the Nav tree open the Services folder (under Station > Config).

2. Right-click AlarmService and select Views > Alarm Db View. The Alarm History is displayed in the view pane.

3. Use the selector box (top left) to choose the required period.
7.2.2.8 Using the Alarm Console

The Alarm Console allows you to view details of each alarm, acknowledge an alarm or add notes to alarms. Notes are useful to record actions (particularly for critical alarms) such as who has been notified, contact numbers and agreed timescales for fixing the problem.

To view specific alarm details:

1. In the Nav tree open the Station > Config > Services folder.
2. Double click AlarmService. The view pane will display the Alarm Service wire sheet.
3. Double click on the required ConsoleRecipient to open the Alarm Console:

Current alarms are indicated by a red icon, returned to Normal alarms are indicated by a green icon.
4. Double click an alarm line to open the **Alarm Viewer**. This will list all current and cleared alarms related to the same alarm condition:

![Alarm Viewer screenshot]

5. Double click an alarm to open the **Alarm Record** , giving full details of the alarm.

![Alarm Record screenshot]

**To acknowledge an alarm:**

1. Click the alarm in the **Alarm Console** or **Alarm Viewer** or open the **Alarm Record** for a specific alarm.

2. Click the **Acknowledge** button.

*Multiple alarms can be selected and acknowledged at the same time in the Alarm Console or Alarm Viewer by clicking in conjunction with CTRL and/or Shift keys.*
To view or add notes for an alarm:

1. Click the alarm in the **Alarm Console** or **Alarm Viewer** or open the **Alarm Record** for a specific alarm.

2. Click the **Notes** button. The **Notes** window is displayed and any previously added notes will be shown with a timestamp in the top section:

   ![Notes Window](image)

3. Type any new details in the lower section and click the **Add Note** button to save, or click **Close** to close the window without adding a new note.

   You cannot add notes to multiple alarms.

7.2.2.9 Viewing and changing Occupation Times (Scheduler and Calendar) in Saia PCD® Supervisor

**Changing the Weekly Schedule**

The weekly schedule determines the occupation times for a normal week, i.e. no Special Events apply.

1. In the **Nav** tree open **Localhost > Station(Demo_station)**, navigate to the required WeeklySchedule.

2. Double click the WeeklySchedule. The **Scheduler** is displayed in the view pane.
3. Select the **Weekly Schedule** tab.

4. Specify the required occupation times:

   **To add a new time period:**
   Drag the mouse in the required white area of the grid.

   **To make adjustments to existing time periods:**
   Drag the top or bottom edge of the green rectangles to the required time.

   **To set all day occupation:**
   Right click the day and select **All Day Event**.

   **To apply a period a day’s times Monday to Friday:**
   Right click the day and select **Apply M-F**.

   **To remove a time period:**
   Right-click the rectangle and select **Delete Event**.

   **To remove all time periods for a day:**
   Right click the day and select **Clear Day**.

   **To copy a day:**
   Right click the day and select **Copy Day** then right click the day the times are to be copied to and select **Paste Day**.

5. Click **Save**.

**Editing Special Events**

Special events enable different occupation times to be used on specific days.

1. In the **Nav** tree open **Localhost > Station(Demo_station)**, navigate to the required BooleanSchedule.

2. Double click the WeeklySchedule. The **Scheduler** is displayed in the view pane.

3. Select the **Special Events** tab.
4. Specify the required Special Events:

**Add a special event**

1. Click **Add**. The **Add** dialogue box is displayed.

2. Specify a name for the special event in the **Name** box.

3. Select **Date** or **Date Range** in the **Type** box.

   Specify the date(s) the special event applies to:
   
   - **Date**: Specify the day month and year in the appropriate box.
   - **Date Range**: Specify the day month and year for the beginning of the range in the appropriate box in the top row and specify the day month and year for the end of the range in the appropriate box in the bottom row.

4. Click **OK**.
Edit the times

- Click the special event for which the times are to be edited.

  **To add a new time period:**
  Drag the mouse in the required white area of the grid.

  **To make adjustments to existing time periods:**
  Drag the top or bottom edge of the green rectangles to the required time.

  **To set all day occupation:**
  Right click the day and select *All Day Event*.

  **To remove a time period:**
  Right-click the rectangle and select *Delete Event*.

  **To remove all time periods:**
  Right click the rectangle and select *Clear Day*.

  **To ensure non-occupancy outside the specified periods**
  Right click the day and select *Schedule Defaults*.

Rename a special event

1. Right click the special event that is to be renamed.
2. Click *Rename*. The *Rename* dialogue box is displayed.
3. Enter the new name.
4. Click *OK*.
5. Delete a special event
6. Right click the special event that is to be deleted.
7. Click **Delete**. The **Confirm** dialogue box is displayed.

![Confirm dialogue box]

8. Click **Yes**.

9. Click **Save**.

**Editing the CalendarSchedule**

If a CalendarSchedule has been added to specify days different occupation times are used, these days can be edited by add or removing events from the CalendarSchedule.

1. In the Nav tree open Localhost > Station(Demo_station), navigate to the required CalendarSchedule.

2. Double click the CalendarSchedule. The Scheduler is displayed in the view pane.
Add a date

1. Click **Add**. The **Add** dialogue box is displayed.

2. Specify a name for the special event in the **Name** box.

3. Select **Date** or **Date Range** in the **Type** box.

   Specify the date(s) the special event applies to:
   
   **Date**: Specify the day month and year in the appropriate box.
   
   **Date Range**: Specify the day month and year for the beginning of the range in the appropriate box in the top row and specify the day month and year for the end of the range in the appropriate box in the bottom row.

4. Click **OK**.

Edit a date

1. Double click the date that is to be edited.

2. Edit the date as required.

Rename a date

1. Right click the date that is to be renamed.

2. Click **Rename**. The **Rename** dialogue box is displayed.

3. Enter the new name.

4. Click **OK**
Delete a date
1. Right click the date that is to be deleted.
2. Click Delete. The Confirm dialogue box is displayed.
3. Click Yes.
4. Click Save.

7.2.2.10 Viewing a History (Graph)
1. In the Nav tree open the History folder (Station > History).
2. Open the folder for the required controller.
3. Double click on the history that you wish to view. The Chart view is displayed.
Viewing Multiple Plot Graphs

To add another plot to the same chart:
Drag the required history from the Nav tree onto the Chart view.

Adjusting the Displayed Information

To change the displayed time period:
Use the selector (at the top left of the Chart view) to choose the required time period.

To change the horizontal scale:
Mouse over the appropriate scale until the cursor changes to a double arrow.
Drag the mouse left or right to change the scale.

To change the vertical scale:
Mouse over the appropriate scale until the cursor changes to a double arrow.
Drag the mouse up or down to change the scale.

Viewing the Source Data

To view the source data in table form:
Click the View Changer and select History Table.

Exporting a Graph or Data Table

1. In the Nav tree, right-click on the required history and select Export. The Export dialogue box is displayed.
2. In the Select Exporter box select the required export type and file format.
3. Choose the export method (e.g. Save to File).
4. Click OK.

Viewing Live Updates

1. View the desired plot (as described above) and change the view to History Chart.
2. Click the Play button to start getting history updates. At the bottom right corner of the window the message ‘Waiting on first Live Update...’ will appear.
3. When the time period has elapsed the message will change to show ‘Last Live Update’ with the date and time of the update.

If you zoom in on the chart, live updates will not be visible anymore. If you need to see values that are not visible on the chart you need to switch to History Table view.
7.3 Manual start the Saia PCD® Supervisor Station

1. In the Nav tree open 
   My Host > Station(Saia PCD® Supervisor) > Platform > Services.

2. Double click Application Director. The Application Director is displayed in the view pane.

3. Click Start. 
   The station will be started, check that a 'Station Started' message is shown.
Annex A

A.1 Icons

In manuals, this symbol refers the reader to further information in this manual or other manuals or technical information documents. As a rule there is no direct link to such documents.

This sign accompanies instructions that must always be followed.

A.2 Using the Extended Support Options

Saia PCD® Supervisor has the following extended support options that can be purchased:

- **PCD8.SUP-OPC**: Extend the open protocol points with OPC client connectivity
- **PCD8.SUP-DB-CSV**: Extend the capability for the supervisor to interact with Microsoft Excel
- **PCD8.SUP-DB-SQL**: Extend the capability for the supervisor to communicate SQL Server

In order to use these options it is necessary to license Saia PCD® Supervisor with the appropriate license. See chapter 5 Licensing Saia PCD® Supervisor

For details of configuring and using these options refer to the Saia Burgess Controls documentation.
A.3 Contact

Saia-Burgess Controls AG
Bahnhofstrasse 18
3280 Murten
Switzerland

Phone........................................... +41 26 580 30 00
Phone support.............................. +41 26 580 31 00
Fax................................................ +41 26 580 34 99

Email support: ....................... support@saia-pcd.com
Supportsite: ............................... www.sbc-support.com
SBC site: ................................. www.saia-pcd.com

International Representatives &
SBC Sales Companies: .......... www.saia-pcd.com/contact

Saia Burgess Controls Technical Support are only able to provide support for Saia PCD® Supervisor and the Saia Burgess Controls driver features described in this manual. They are unable to provide support for 3rd party drivers and undocumented aspects of Saia PCD® Supervisor’s operation.

Technical Publications
Please send any comments on this or any other Saia Burgess Controls technical publication to support@saia-pcd.com.